Océ User Guide

Océ PRISMAtools
TrueProof V2.0
Contents

1 Introduction ........................................................................................................................................................................ 1
  1.1 Product Architecture ....................................................................................................................................................... 2
    1.1.1 TrueProof on a Host-System ........................................................................................................................................ 4
    1.1.2 TrueProof under PRISMAproduction .......................................................................................................................... 5
  1.2 Restrictions ......................................................................................................................................................................... 6

2 Installation ........................................................................................................................................................................... 7
  2.1 System Requirements ........................................................................................................................................................... 7
  2.2 Preparing the Installation .................................................................................................................................................... 7
    2.2.1 Windows 2000 / XP ...................................................................................................................................................... 7
  2.3 Installing the Océ TrueProof Server under Windows ......................................................................................................... 8
    2.3.1 Software Packages of Océ TrueProof .......................................................................................................................... 8
    2.3.2 TrueProof Converter ...................................................................................................................................................... 9
    2.3.3 TrueProof Operator Panel ........................................................................................................................................... 9
    2.3.4 TrueProof Viewer ......................................................................................................................................................... 9
    2.3.5 Installing the Océ TrueProof Software ......................................................................................................................... 10
    2.3.6 The TrueProof License on the TrueProof Server ....................................................................................................... 13
  2.4 Removing Océ TrueProof .................................................................................................................................................... 15
  2.5 Disableing Media Sensing in Windows 2000....................................................................................................................... 17
  2.6 Update Installation .............................................................................................................................................................. 18
  2.7 Testing the Connections ....................................................................................................................................................... 18
    2.7.1 Testing Connection between Operator Panel and Converter .......................................................................................... 18
    2.7.2 Testing Connection between TrueProof cache and Viewer ........................................................................................... 20
  2.8 Installing an Update of the Functional Code .................................................................................................................... 21

3 Working with Océ TrueProof (Windows) .......................................................................................................................... 23
  3.1 Initial Configuration ............................................................................................................................................................ 23
    3.1.1 Quick Start ................................................................................................................................................................. 24
    3.1.2 About Configurations/Setups ................................................................................................................................... 25
    3.1.3 Job Control and Configuration of the Spooling System ............................................................................................... 28
    3.1.4 Logical Connection to Host .................................................................................................................................... 32
3.1.5 Configuring Filters ................................................................. 33
3.1.6 Configuration of the Mail Service ...................................... 37
3.2 Functions of the Océ TrueProof .............................................. 38
  3.2.1 TrueProof Converter window ............................................. 38
  3.2.2 TrueProof Operator Panel ................................................. 38
  3.2.3 'Converter' Menu ............................................................. 41
  3.2.4 'Setup' Menu ................................................................. 43
  3.2.5 'Configuration' Menu ...................................................... 46
  3.2.6 'View' Menu ................................................................. 68
  3.2.7 'Output' Menu ............................................................. 70
  3.2.8 'Options' Menu ............................................................ 71
  3.2.9 Help Menu ('?') ............................................................ 72
3.3 Configuration of the Tool Bar .................................................. 73
4 TrueProof Cache Browser ....................................................... 75
  4.1 View stored jobs ................................................................. 76
  4.2 Start the viewer with a corresponding job ......................... 76
  4.3 Start the viewer in the continuous mode ............................. 76
  4.4 Deletion of documents ....................................................... 76
  4.5 Generation of forms ............................................................ 77
  4.6 Assign different form names to forms/change form names ...... 78
  4.7 Deleting forms ................................................................. 78
  4.8 Searching for Keywords ...................................................... 79
5 Working with the Océ TrueProof Viewer (Windows) .................. 81
  5.1 Main Window ........................................................................ 82
    5.1.1 Using the Page Area ..................................................... 82
    5.1.2 Using the Thumbnail Area .......................................... 82
    5.1.3 Using the Navigator Area .......................................... 83
    5.1.4 Using docking windows .......................................... 83
    5.1.5 Menu and Tool Bar Functions ................................... 84
  5.2 Status Bar ........................................................................ 88
6 Working with Océ TrueProof (PRISMAproduction) .................... 89
  6.1 Installing the TrueProof Viewer under PRISMAproduction ...... 89
  6.2 Installation of the Operator Panel ....................................... 89
  6.3 Configuring a TrueProof Printer on the Print Server .......... 90
  6.4 Launching the Operator Panel ............................................. 90
Contents

6.5 Launching Océ TrueProof Viewer via PJM.................................................................90
6.6 Functions of the TrueProof Viewer.........................................................................91

A Appendix ..................................................................................................................93
A.1 Disableing Media Sensing in Windows 2000............................................................93
A.2 Working with Configuration Files...........................................................................94
A.3 Troubleshooting......................................................................................................96

Glossary .......................................................................................................................103

Index ..........................................................................................................................109
Introduction

1 Introduction

Océ TrueProof is a tool for viewing pixel-equivalent images of print jobs on-screen under Windows or PRISMAproduction. This is done by routing the data stream of the print job to a virtual printer, which acts as an IPDS network printer, installed on the TrueProof server.

Like a printer TrueProof is connected to a host or print server, which receives IPDS or PCL5e print data (HP-GL is not supported anymore).

The print data are processed to raster images by the original functional code of a Océ high performance printer. On a real printer, these images would be transferred to paper. In TrueProof, on the other hand, the print pages are processed by the TrueProof Converter. This application receives the print pages in exactly the form in which they would be printed and stores them as bitmaps in a cache.

As on the equivalent printers, the real throughput depends on a number of factors, one of these being the way the print job is composed and structured. If resources need to be loaded, for instance, the output rate will be affected. Also important is the speed at which the host or print server can supply data to TrueProof, and the speed at which the image data can be transferred to the cache.

You can boot TrueProof as either an IPDS or PCL printer by loading the appropriate functional code. You also activate the resolution of your choice – 240 dpi, 300 dpi, 600 dpi or auto – when you boot the system.

Océ TrueProof V2.0 can be used as a stand-alone solution without PRISMAproduction or a PRISMA workflow. In such a configuration, TrueProof emulates an IPDS printing system, so it can also be connected to other makes of print server as well as Océ, provided the server can drive an IPDS printer via TCP/IP and create IPDS as its output.

You can also view the data ‘remote’ on a PRISMAproduction print server. In this case the operating panel, the TrueProof browser and viewer are running on PRISMAproduction.

Océ TrueProof V2.0 is available for PRISMAproduction V3.x.

The Océ TrueProof software comprises five components: TrueProof Browser, TrueProof Viewer, Data Stream Converter, Java Environment and Operator Panel. The print data is composed by the printer functional code software. A converter then converts it to a format which TrueProof can use for the Viewer. The TrueProof Viewer then outputs the data on the screen.
Operator Panel, TrueProof Viewer, TrueProof Browser and Data Stream Converter are installed together on a Windows server, called the Océ TrueProof server, thus providing all components to view the data stream (TrueProof viewer and operator panel).

The operator panel is a Java application, so the Java runtime environment V1.4.2 must be installed.

**Product name and version**

<table>
<thead>
<tr>
<th>SW-Category</th>
<th>SW-Component</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRISMAtools</td>
<td>TrueProof</td>
<td>2.0</td>
</tr>
</tbody>
</table>

### 1.1 Product Architecture

**Connection to the host**

TrueProof connects to the host or print server by means of a network adapter in the TrueProof PC. The TCP/IP protocol is used.

**Print Data Stream**

TrueProof can process the same print jobs as a normal printing system. Bear in mind, though, that TrueProof "prints" simplex in the continuous forms mode and that two-up mode will be disabled.

TrueProof processes IPDS and PCL5e data streams (but not HP-GL). Equipped with the right print server and spooling software, TrueProof can also convert AFP, Xerox and other print data streams.

**Structure of the Input Data**

What we understand by a print job is a set of print data that produces a particular sequence of pages on a printer. For most spoolers, a job is the smallest processable element. Some systems permit operations on the page level – for example, selecting and printing a particular page range in a job. In the majority of cases, TrueProof is able to identify the boundaries of print jobs.

Print jobs include additional elements that provide instructions to post-processing systems such as inserters, stitchers and binding equipment. These elements serve as controls to mark a particular series of pages as belonging together, enabling the post-processing equipment to treat these pages as a unit. In TrueProof you can use this boundary as job boundary.
In many cases, TrueProof is able to identify document boundaries within print jobs and map these boundaries to its viewing system. However, whether or not TrueProof can do this will depend on the page description language, the print application, spooler and printer driver. As a rule, the possibilities are better with AFP and IPDS data streams than with PCL5e.

**Printer Settings**

You make certain basic settings by choosing a particular functional code and rebooting: the kind of page description language (emulation) being used and the print resolution. You can also make a range of other settings for TrueProof, exactly like the parameters you would set on a normal printer. The settings that are particularly relevant to data conversions are the paper size, paper shifts and automatic page rotation (plus other settings that can be made on printers with SRAx controller). Note that you cannot set all settings of the SRA3 functional code.

**Status Messages to the Host**

Like any normal printer, TrueProof sends status messages (Ready, Not Ready, "soft" and "hard" errors) to the host or the print server. A "soft" or "hard" error will always require corrective action on TrueProof. Its behaviour depends greatly on which spool system and which emulation (IPDS or PCL) is being used. Normally, TrueProof will behave much like any normal printer.
1.1.1 TrueProof on a Host-System

The print data generated by the spool system of a host computer is converted into raster images by the TrueProof converter. These images are stored in a cache which can be accessed by the TrueProof viewer and the TrueProof browser under Windows and Linux via the entire network. The TrueProof converter is controlled by the UI of the operator panel via SNMP, which can also be located anywhere in the network. Multiple instances are allowed.
1.1.2 TrueProof under PRISMAproduction

The print data generated by the PRISMAproduction spool are sent directly to the TrueProof server. This converter acts like a real Océ high performance printer, which is connected via TCP/IP. It converts the print data to raster images using the original functional code. The TrueProof converter is controlled by the UI of the operator panel via SNMP. The raster data are stored in the TrueProof cache and are transferred to the TrueProof viewer on the PRISMAproduction server by the database export module installed on the Windows computer. The viewer allows you a true-to-life presentation and a precise soft-proof of the print data.
1.2 Restrictions

- In the continuous mode CustomTone is not supported.
2 Installation

2.1 System Requirements

Océ TrueProof requires the following hardware and software:

- Windows 2000 with service pack 1 or Windows XP on a Pentium with at least 800 MHz and 512 MB RAM (recommended: 1.6 GHz and 768 MB RAM).
- SNMP service installed

2.2 Preparing the Installation

2.2.1 Windows 2000 / XP

- Installing SNMP
  1. First check under ‘Start’ -> ‘Settings’ -> ‘Control Panel’ -> ‘Services’ if a SNMP service is already installed on the TrueProof PC. You have to install the service if it’s not in the list.
  3. After successfully installing SNMP, the following settings have to be made:
     Per default access to SNMP is set to ‘Read only’ under Windows 2000. For the TrueProof to work properly you have to modify the settings in the ‘Security’ of the SNMP Service properties dialog tap to ‘READ CREATE’.
2.3 Installing the Océ TrueProof Server under Windows

2.3.1 Software Packages of Océ TrueProof

The entire TrueProof software is delivered on a CD-ROM. The CD contains these folders:

- **Document**
  Manuals

- **Linux**
  - **Caldera**
    Contains the operator panel for Linux

  - **Java Apps**
    Contains the TrueProof operator panel for the Linux computer. Additionally you find here ‘jGauges’, a user-configurable interface for displaying important operating states of TrueProof.

  - **Prisma**
    Contains RPMs for the operator panel and the viewer in its latest version to be installed under PRISMAproduction.

- **Windows**
  - **Java**
    Contains the required Java Runtime Environment, which is installed automatically by the installation routine.

  - **Tools**
    - **mysqigui**: User interface of the cache browser.
    - **ShowLicense**: Tool for the display of installed licenses.

  - **TrueProof V2.x**
    (routine for installing TrueProof and its components (apart from SNMP): TrueProof Browser, Converter, Operator Panel, Java Runtime Environment, Viewer and some tools.) You can choose whether to install all or only some components (e.g. to install the operating panel on different PCs).

  - **Viewer**
    The installation routine for the TrueProof Viewer.

  - **DataBase**
    Installation routine for the TrueProof cache.

In addition to these files you find the file ‘Readme.txt’ on the CD, which contains information on the initial installation of the TrueProof software on a Windows PC.
2.3.2 TrueProof Converter

The TrueProof Converter is the central component that takes print data from the host and creates raster images for use by other applications.

The TrueProof converter consists of:

- The program "opssra.exe", which is displayed on the screen as a converter window and which loads the modules of the function code,
- The Functional Code (FC) of the SRA3 controller: this receives the print data via channels, interprets the data and converts it to raster image format;
- TrueProof-specific DLLs of the FC. These components receive the raster data created by the functional code, compress it to a format suitable for the viewer, convert and filter the index data, sort pages into jobs and stacks, and finally create folders and files in the TrueProof cache.

2.3.3 TrueProof Operator Panel

The TrueProof Operator Panel enables the user to control the converter, load setups and make settings.

The panel uses SNMP to communicate with the TrueProof Converter. SNMP is a simple network protocol for managing printers, computers and other network components. It is based on the TCP/IP network protocol. This approach enables you to control the converter via an operator panel installed on a remote computer in the network.

You must make sure that this protocol is accepted by every network component on the line of communication between the TrueProof PC and the PC with the operator panel installation.

The operator panel is based on Java, so it can also be installed on non-Windows computers. The installation media provide a Java Runtime Environment for the Windows platform.

If you are using a different architecture, you will have to obtain the Java Runtime for your platform and copy the Java operator panel files manually to the destination system. You can find these files on the CD.
2.3.4 TrueProof Viewer

The TrueProof Viewer is an application for Microsoft Windows 2000/XP. It connects itself to the TrueProof cache if necessary via the network and has access to all data in this cache.

2.3.5 Installing the Océ TrueProof Software

1. Insert the TrueProof installation CD and change to the CD drive.
2. In the root directory double-click 'Setup.exe' and start the installation.
3. Select the desired language for the installation process:

![Select Setup Language](image1.png)

4. Read the following text file and click 'Next' if the prerequisites described are correct.

![Setup Text File](image2.png)
5. In the next step choose the components of the software which are to be installed.

If there is no SNMP service installed or if it’s not configured correctly, the following message prompts you to install and/or configure the SNMP service as described on page 7:
6. Afterwards you are asked to select a program folder. The folder "Océ Printing Systems\TrueProof 2.0" is offered by default.

7. In the next window select the drive, where the TrueProof cache is to be installed.
8. The progress of the installation is displayed in the following window:

Notice: If you already have TrueProof installed, this is uninstalled automatically before the new installation begins.

2.3.6 The TrueProof License on the TrueProof Server

The license details are generated from hardwired content on the network adapter. Each license is valid for one particular adapter. If the adapter is replaced, a new license has to be obtained.

Océ TrueProof is enabled for use by entering the valid license details. To do this copy the license file into the directory \C:\SRA3\PRINTER\SWKEY.

The following license key must be installed on the TrueProof server (Windows NT) for Océ TrueProof:

<table>
<thead>
<tr>
<th>Functions/components</th>
<th>Name of license</th>
<th>Key Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>TrueProof</td>
<td>TrueProof</td>
<td>2.0</td>
</tr>
<tr>
<td>TrueProof (Variostream)</td>
<td>TP_VARIOSTREAM</td>
<td>2.0</td>
</tr>
<tr>
<td>TrueProof (Varioprint)</td>
<td>TP_VARIOPRINT</td>
<td>2.0</td>
</tr>
<tr>
<td>output converter for PS</td>
<td>TP_PS_OUT</td>
<td>2.0</td>
</tr>
<tr>
<td>output converter for PDF</td>
<td>TP_PDF_OUT</td>
<td>2.0</td>
</tr>
<tr>
<td>output converter for PCL</td>
<td>TP_PCL_OUT</td>
<td>2.0</td>
</tr>
</tbody>
</table>
If you do not have this license available, you can still use the product for a 30-day evaluation period. This demo mode is indicated on the operator panel by a message and in the Viewer by a black diagonal bar. The demo period cannot be extended by changing the system time:

A warning about the missing license appears in the alert table ('View' -> 'Alert'):

<table>
<thead>
<tr>
<th>Index</th>
<th>Severity</th>
<th>Description</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>13</td>
<td></td>
<td>No valid licence</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td></td>
<td>For MAC: 09:00:00:11:37:11</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td></td>
<td>Runs in Demo Mode 30 days</td>
<td></td>
</tr>
<tr>
<td>37</td>
<td></td>
<td>Display information changed</td>
<td></td>
</tr>
</tbody>
</table>

**Notice:** If you have already recorded jobs in demo mode, bear in mind that the black bar (indicating demo mode) will NOT be removed when you install the license later. The bar will not be present in any new jobs you record.
2.4 Removing Océ TrueProof

To remove Océ TrueProof, choose 'Start' -> 'Program Files' -> 'Océ Printing Systems' -> 'TrueProof' -> 'Uninstall TrueProof'. You must first close the TrueProof Converter with 'Converter' -> 'Down' and close the operator panel with 'Converter' -> 'Exit Panel'.

During the uninstall procedure, you are asked if you want to keep important files for installing the program again at a later time, or whether you want to delete everything.

The important files are located in the folders C:\sra3 (setups, traces and log files) and in C:\user (resources loaded by users).

If you select to delete all the files, the above folders are also removed from your system.
If the TrueProof installation utility also installed other modules required for running the software – the Java Runtime Environment and TrueProof Viewer modules – you can decide whether or not to have these modules deleted with TrueProof:

If the modules were not installed by the TrueProof installation utility, they are not shown in this dialog. If you wish to delete them, you have to do so manually.

You must reboot the system to complete the uninstall procedure.
2.5 Disableing Media Sensing in Windows 2000

Introduced with Windows 2000 the newer versions of Windows contains the "Media Sensing" feature, detecting wheater your network media is in a link state.

When e.g. no network is attached to your ethernet adapter, the TCP/IP protocol is removed from that adapter.

In that state without bound TCP/IP protocol, TrueProof will not be able to boot properly. Mostly it will crash in an early bootstate. Anyhow you cannot go online. If you want to use TrueProof without a connected network, you'll have to switch off the "Media Sensing" in Windows. To do this, just start the file:

C:\Sra3\Converter\Tools\Misc\DisableMediaSense.reg by double clicking on it and reboot the computer.

For more information read:
C:\Sra3\Converter\Tools\Misc\DisableMediaSense.txt.

Note: Disabling Media Sensing is mainly important when using TrueProof on a Laptop without network connections.
2.6 Update Installation

In case of an update installation, you have to deinstall the actual version. The setup program offers you to keep important files for the new installation.

You can also remove a previous version of TrueProof manually via 'Start' -> 'Settings' -> 'Control Panel' -> 'Add/Remove Programs' -> 'TrueProof'. The deinstallation routine is called automatically, if you install a new version of TrueProof. The viewer itself, which formerly was a separate software package, has to be removed manually using 'Settings' -> 'Control Panel' -> 'Add/Remove Programs', if you directly switch from version 1.0 to version 2.0.

2.7 Testing the Connections

There should only be two connections running:

- Connection between TrueProof Operator Panel and TrueProof Converter
- Connection between TrueProof cache and TrueProof Viewer

2.7.1 Testing Connection between Operator Panel and Converter

Notice: You only need complete the steps below if the TrueProof Operator Panel and Converter are installed on different computers. If so, the IP address or name of the computer on which the converter is installed must be communicated to the Operator Panel when this utility is launched.

Perform the following steps on the Operator Panel PC:

1. Right-click the icon 'TrueProof Bdf' on your desktop and choose 'Properties' from the shortcut menu.

2. Open the 'Shortcut' tab in the 'Properties' dialog box. The following path must be entered:

   C:\WINNT\system32\javaw.exe -classpath .;jBDF.jar com.oce.ops.bdf.is/BdfFrame 127.0.0.1
In the 'Target' field, the batch file for launching the operator panel, "Bdf_Java.bat", is transferred with parameter "127.0.0.1" (this is correct when the panel and converter are installed on the same computer).

3. Overwrite "127.0.0.1" with the address of the computer on which the TrueProof Converter is installed.

4. Confirm the dialog box with 'OK'.

Perform the following steps on the Converter PC:

5. Switch on the PC and boot Windows 2000/XP.

The following actions should be completed for both types of installation – with the Operator Panel and Converter on separate PCs or on the same PC:

6. Double-click the 'TrueProof Bdf' icon to launch the TrueProof Operator Panel.
   If the display shows the message "No connection", the panel was unable to establish a connection. There is an error condition.

   ![Image of 'No connection' message]

   If the message "Connection established" is shown, the attempt was successful.

   ![Image of 'Connection established' message]

7. Choose 'Converter' -> 'Boot' in the menu to launch the TrueProof Converter. Booting the converter takes about 20 seconds. To track the boot procedure you can open the 'TrueProof Converter' window of the 'Opsra.exe' program, which is hidden in the task bar soon as you press the boot button of the TrueProof operator panel.
Testing the Connections

Installation

8. Click Ready.

2.7.2 Testing Connection between TrueProof cache and Viewer

1. Choose ‘View’ -> ‘Output’ in the Operator Panel menu to launch the TrueProof Viewer.
2. In the TrueProof Viewer, choose ‘Softproof’ -> ‘Select’ a softproof job.

The following message appears if the connection has been established but no jobs are ready for viewing.

An error message is issued if there is no connection between the cache and the Viewer.

Verify that the cache is running on the computer (spd -?, spd -s) and that the correct command line for the Viewer is entered in ‘Options’ -> ‘Viewer Preferences’.

When you launch the Viewer via the desktop icon, you can check the IP address in the shortcut:

Entering the IP address in the shortcut

1. In the list of Program Files in the Start menu, right-click the icon for the TrueProof Viewer and choose ‘Properties’ from the shortcut menu.
2. Display the 'Shortcut' tab in the 'Properties' dialog box.

3. Append the following entry to the content of the destination field:
   C:\OPS-SW\TP-Viewer\tpBrowser.exe <IP-Address>

   Enter the IP address of the computer on which the cache is installed. You can also enter the computer name instead of the four-digit number.

2.8 Installing an Update of the Functional Code

The Functional Code of the SRA3 controller is updated at regular intervals to accommodate technical advancements or fix errors. You can install a new Functional Code in Imagestream if you need to the changes provided. To update the Imagestream Converter, you need a set of disks comprising:

- Original Functional Code of the controller for the emulation you use
- Imagestream-specific extensions

Always install the Functional Code first, and then the Imagestream-specific extensions.

1. Insert disk 1 of the original Functional Code in the disk drive.

2. Display the content of the diskette in the Explorer. Double-click "Install.bat" to begin the installation.

3. Change diskettes when the program prompts you to do so. Do not forget to remove the final diskette from the drive after completing the update.

Notice The installation procedure might be slightly different for latest versions of the Functional Code. Please read the notices provided on the installation media.
3 Working with Océ TrueProof (Windows)

This chapter explains the functions and workflows of Océ TrueProof.

3.1 Initial Configuration

After installing TrueProof and integrating it into the Windows network, you have to complete the initial configuration. This chapter explains how to proceed.

**Notice:** You must set up the Windows network and configure the connection to the archive cache before proceeding with the initial configuration of TrueProof.

You have to adjust the factory and installation defaults to the requirements of the platform and environment in which you intend to run the TrueProof Converter.

Complete the following steps:
- Configure the spooler
- Establish a logical connection with the host
- Configure options for filtering index data for the viewing system
- Establish a logical connection with the viewing system
- Configure paper dimensions, size and properties of image files

You must put the TrueProof Converter to Stop state in order to make these settings. Likewise, before you can change channel settings, you have to put the channel in question offline.

The changes are stored in a working copy of the setup files and are valid for subsequent sessions. The changes are however not actually saved to the setup until you execute the ‘Setup’ -> ‘Save’ command. Prior to executing the command you can discard all your changes by reloading the current setup. This restores the status of the setup as it was the last time it was saved.

Information about setups is provided in “About Configurations/Setups” auf Seite 25.
3.1.1 Quick Start

After installing TrueProof, you have to take the following steps to configure the system.

1. Start the TrueProof Operator Panel.
2. Boot the converter with 'Converter' -> 'Boot'
3. In the Boot dialog select the emulation (IPDS/PCL), the corresponding FC version (if more than one version is installed), the resolution and the printer type (VarioStream = continuous forms emulation, VarioPrint = cut sheet emulation).
4. Choose 'Setup' -> 'Configuration' -> 'Paper Size...' and set the paper size you want to use.
5. Choose 'Setup' -> 'Configuration' -> 'Text Filter...' and select the character mapping table. The preferred table for IPDS is 'EBCDIC.CHS' and for PCL 'ISO_GER.CHS'.
6. Choose 'Setup' -> 'Configuration' -> 'Output Modules...' and check the path for storing the image and text files. You can select different output modules for storing the printfiles as PDF, PS or PCL files (if the required licenses are installed).
7. The IP address under which TrueProof receives print data is assigned by the operating system: this is therefore simply the address of the PC.
8. After successful completion of this first test, configure the setups for the types of job you will be running.

The remainder of this chapter describes in detail what you have to configure and how to do it.
3.1.2 About Configurations/Setups

After you have set up the TrueProof device and made the necessary settings for the Windows network, you have to configure the TrueProof Converter for the first session. This section describes how you go about doing this.

TrueProof stores settings in an initialisation file (also referred to as an INI file), normally
C:\Sra3\PrnSetup\_INT and in configuration files (CFG or config files). The configuration files are loaded manually. The CFG files are located in the folder:
C:\Sra3\PrnSetup\ImageStream\ and C:\SRA3\PrnSetup\Controller.

The INI file contains device parameters and settings that are valid for all configurations. The connection parameters to the host are stored here, for example, but not the paper sizes.

Settings specific to particular jobs, such as paper sizes, size and position of clipped sections and filter parameters, are stored in the CFG file.

It is a good idea to define and use different setups if you are generating data from different source formats, etc. Users can load all the requisite settings at once simply by loading the appropriate setup.

The easiest way to make a first configuration is to load an appropriate sample configuration, save it under a different file name and, finally, to adapt it to your needs. Further details are provided in ‘Functions of the Océ TrueProof’ on page 38.

- Make a backup copy of the folder C:\Sra3\PrnSetup and keep it in a safe place. You should make a copy of this folder after making important changes to setups.
- Start the TrueProof Converter with ‘Converter’ -> ‘Boot’ on the operator panel.
Choose ‘Setup’ -> ‘Load’ and select a suitable configuration. A brief profile of the setup is given in the ‘Description’ field.

Click ‘Load’. You are then prompted to boot the converter to activate the selected setup.
You can also define your own setup:

- Choose 'Setup' -> 'Save as...' and enter a name of your choice.

- The name must have between four and 14 characters. The characters ";", ";", """, "?", "/", "," or ">" are not permitted. The program does not check the validity and uniqueness of the name.

- Click 'Save'. The current configuration is saved under the name you have assigned.
You can of course also delete setups.

To do this, choose ‘Setup’ -> ‘Delete’:

- Make sure the setup you are deleting is not the one currently in use.

3.1.3 Job Control and Configuration of the Spooling System

TrueProof (normally) generates an image file and an index file from each print page. Printer operators use terms like print jobs, pages, sheets, stacks, etc. In contrast, users of data processing systems work with terms such as writing, document, file, etc. Archive systems store images and generally structure them according to the terminology with which the users are familiar – which means that pages are assigned to documents and documents are assigned to files, etc.

TrueProof is a neutral system as far as applications are concerned, which means that it does not know file names of spool files, or which print pages belong to a document. With the right kind of configuration, TrueProof can distinguish between print jobs, it can store different print jobs as different documents in the cache and ensures that the viewing system is notified about the beginning and the end of a print job. TrueProof can also subdivide print jobs into stacks, and their files can again be stored in their own subfolder.

The assignment of pages to documents has to be done prior to caching. It may be possible to use stack separation for the separation of documents.
3.1.3.1 Job Separation

1. Choose 'Setup' -> 'Configuration' -> 'Separation'.

![Separation settings](image)

2. Select the type of job or stack separation you wish to use. You can adjust the settings to your particular requirements by editing the entries in the config file.

TrueProof interprets a change of the edge marks as the beginning of a new job and a change of the Mark Forms as the end of a job. Configure the spool system so that it will change the edge marks every time a new job starts or have it insert mark forms on the last page of the job. We generally recommend printing a header and trailer page because these pages include information about the print file, the date of print, etc. These pages can also be used to verify the integrity of the job. They can either be archived with the job or discarded by the import program.

Version 2.0 can retrieve job information from the print data stream, more specifically from fields in the IPDS command 'XOH Define Group Boundary' or PCL command @PJL JOB and @PJL RDYMSG. A change to the value is interpreted as the start of a new job. You can also turn off the job start by editing the entry in the config file (see appendix A.4.2, FltJbm SepMode_Hostxxx -Events). The information has to be provided by the spool system, and you might have to alter the spool configuration to make sure the right information is placed in the IPDS structured fields (XOH DGB) or PJL commands.

TrueProof can execute a job or stack change after a predefined number of pages, for example, 1000. Together with the criterion mentioned above, the system will change the subfolders after a maximum of 1000 pages. Since TrueProof stores all the print pages belonging to one job in one directory and since older file systems perform less well if there are a lot of files stored in a single folder, we recommend a job separation after 1000 pages, at the most.
Ultimate control over the job separation feature lies with the user. You can always stop TrueProof via the menu or by pressing the Stop key on the operator panel. Then you can close the current job with ‘Output’ -> ‘Close current job’ in the menu, regardless of the state the job is in on the host.

3.1.3.2 Dealing with Corrupt Jobs

This is how you end a corrupt job and ensure that the next job begins correctly:

1. Abort the job on the host or spooler.
2. Drain TrueProof and wait until there is no data left to store. You can keep track of this using the Viewer, operator panel status bar and DtaRdy LED.
3. Choose ‘Output’ -> ‘Start new Job...’.

Notice: If you do not drain TrueProof, pages belonging to the corrupt job might be written to the new folder created for the next job.

A possibly configured post processing for the job is not executed, but the data is not deleted!

3.1.3.3 Page Definition and Form definition

In TrueProof, you define the paper format just as you do with a real printer. When printing A4 pages real printers will often print in landscape mode, for reasons of performance. The printer will do this automatically if you set landscape mode.

In TrueProof, you would generally not want this effect. The reason is that images on pages formatted for portrait mode would have to be rotated again for display. You define the position and the orientation of the logical page on the physically defined page by making settings in the formdef and pagedef.

The FORMDEF contains information on how the logical pages of a file are to be printed, how many copies are to be made of the individual pages and whether these copies should be different from each other.

The PAGEDEF is needed for printing line data. Here you define the height and width of the page, plus the orientation/direction of rotation of the lines.
The following table lists the settings recommended for the pagedef and formdef in TrueProof. Of all the possibilities to combine parameters, the table shows those in which the origin is in the top left corner and lines are printed from top to bottom.

<table>
<thead>
<tr>
<th>Paper format</th>
<th>PAGEDEF DIRECTION</th>
<th>PAGEDEF ROTATION</th>
<th>FORMDEF DIRECTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Portrait</td>
<td>Across</td>
<td>0</td>
<td>Port</td>
</tr>
<tr>
<td>Landscape</td>
<td>Across</td>
<td>0</td>
<td>Land</td>
</tr>
</tbody>
</table>

**Page copies**

In the formdef, you define how many copies you want to print of each page and whether you want the copies to be different from each other. Identical copies are irrelevant when working with TrueProof – it is not a useful feature in this context. But it does make sense to have copies that differ.
3.1.4 Logical Connection to Host

After installing TrueProof, you have to configure the connection to the host.

TrueProof is connected to a host or print server just as a printer would be. The software connects solely via Ethernet with TCP/IP, and only one channel (A) is supported.

**Notice:** The emulation and resolution used in TrueProof must match the host and spooler and fit in with the host/spooler jobs and resources.

On the host or spooling system, set the destination address for the print data – on the software version of TrueProof, this is simply the IP address of the PC on which the converter is running.

To view or edit the port number, click 'Config Channel' in this dialog box.
3.1.5 Configuring Filters

The metacommand filter converts the raw index data and separates the jobs. You can configure the filter via the configuration dialog box.

1. Choose 'Setup' -> 'Configuration' -> 'Text Filter...'. This opens the 'Filter' dialog box.

2. Select all the information that you want to send to the TrueProof cache. If your host application provides index data in NOOP containers, it may be enough to select 'Text from NOP-Control-Sequences'. If not, it may be useful to select all the options available.

3. Under 'Name of character set', select a code page (character mapping table). The most suitable table for PCL is iso_ger.chs or ansi.chs; for IPDS, ebcdic.chs. If the system does not convert all the characters satisfactorily, you can modify the tables or create your own (see 'Creating Mapping Tables' on page 33).

3.1.5.1 Creating Mapping Tables

In the print data that is transferred from the host to TrueProof, text is normally coded in EBCDIC – particularly in the acquisition of IPDS print data. In open systems such as PC systems and UNIX systems, text is coded in ASCII. In PCL, text is normally coded in ASCII. The generating system and the target system can therefore use different character assignments.

Character assignment tables – or mapping tables – are files containing specifications for converting character code in the print data into character code for the raw index data of the archive system.
If the table is not suitable, the display in the Index window may look like the following figure. Normally, the raw index data is readable. That, however, naturally depends on the destination system.

**Structure of mapping tables**

Each table contains entries in the following format:

@<Code of the original character in Hex>=<"Is changed to " Hexcode>

Text that is outside such entries is considered to be comments. A character code in the print data for which there is no entry in the table is transferred "as is".

The following figure shows part of a mapping table for TrueProof. The text after the semi-colon is comment.

```
@5E=Æ
BC1=Ø; Å
BC2=Ø2; Æ
BC3=Ø3; Å
BC4=Ø4; Å
BC5=Ø5; Å
BC6=Ø6; Å
BC7=Ø7; Å
```
3.1.5.2 Importing character tables into TrueProof

Print data that is sent from the host or print server to TrueProof can be converted by meta-filters to any other 8-bit character set. If the destination system is a UNIX system, you will probably wish to convert to ASCII. If the target is a Microsoft system, you will wish to convert to the Windows character set.

IPDS print data that is transferred from the host to TrueProof is generally coded in EBCDIC. This data must be converted to ASCII. Within these basic coding schemes, there are mapping tables that define the position of the individual characters in a character set. The coding defined by the ISO under the designation 8859-1 is in widespread use on open systems. Under EBCDIC, the SEB242 coding has much in common with the ISO8859-1 code.

The table that is set up at installation time converts EBCDIC-SEB242 into ISO8859-1. The following figure shows which characters are converted.

```
Font: EBCDIC SEB242 -> ISO8859-1

<table>
<thead>
<tr>
<th>EBCDIC</th>
<th>ISO8859-1</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td>6</td>
<td>6</td>
</tr>
<tr>
<td>7</td>
<td>7</td>
</tr>
<tr>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>9</td>
<td>9</td>
</tr>
<tr>
<td>A</td>
<td>A</td>
</tr>
<tr>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>C</td>
<td>C</td>
</tr>
<tr>
<td>D</td>
<td>D</td>
</tr>
<tr>
<td>E</td>
<td>E</td>
</tr>
<tr>
<td>F</td>
<td>F</td>
</tr>
<tr>
<td>G</td>
<td>G</td>
</tr>
<tr>
<td>H</td>
<td>H</td>
</tr>
<tr>
<td>I</td>
<td>I</td>
</tr>
<tr>
<td>J</td>
<td>J</td>
</tr>
<tr>
<td>K</td>
<td>K</td>
</tr>
<tr>
<td>L</td>
<td>L</td>
</tr>
<tr>
<td>M</td>
<td>M</td>
</tr>
<tr>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td>P</td>
<td>P</td>
</tr>
<tr>
<td>Q</td>
<td>Q</td>
</tr>
<tr>
<td>R</td>
<td>R</td>
</tr>
<tr>
<td>S</td>
<td>S</td>
</tr>
<tr>
<td>T</td>
<td>T</td>
</tr>
<tr>
<td>U</td>
<td>U</td>
</tr>
<tr>
<td>V</td>
<td>V</td>
</tr>
<tr>
<td>W</td>
<td>W</td>
</tr>
<tr>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Z</td>
<td>Z</td>
</tr>
</tbody>
</table>

You may not find a corresponding character in ISO8859-1 or another ASCII table for all the characters in your EBCDIC table. Characters for which no mapping is defined in the table are not converted. You should therefore define a mapping for every character. Characters that are not included in ISO8859-1 should be mapped to substitute characters. In the default table, such characters are replaced by blank fields.

Some mapping tables are defined by default as files with the extension CHS. The CHS files are located in the folder "c:/Sra2/ISTream/Charset".
This is how you convert characters and import the mapping table into TrueProof:

1. Navigate in Windows Explorer to the folder `C:\Sra3\Istream\Charset`.
2. Make a copy of the CHS file and give the copy a name like "MyEbcdic.chs".
3. Open a new file with an ASCII editor, e.g. Notepad.
4. Edit the character definitions. Observe the following syntax for the mapping of each individual character: `@<source character>=<destination character>`.
5. Save the file.
6. Restart Windows on the TrueProof device in order for the table to be recognised by TrueProof.
7. Start TrueProof, and choose 'Setup' -> 'Configuration' -> 'Filter'.
8. In the dialog box, select the new table under 'Name of character set'.
9. Confirm the 'Filter' dialog box and save the settings in the setup with 'Save as...'

**Special mapping tables**

TrueProof uses the tables `_Filter_E.CH5` and `_Filter_O.CH5` to convert job information. The names of these tables are predefined and must not be changed.

When processing IPDS, TrueProof can take job information from the "Define Group Boundary (XOH DGB) structured field; with PCL it can take job information from the commands "@PJL JOB" and "@PJL RDYMSG". These files can be used to create file and path names (see "Job Separation" auf Seite 29). If the information in XOH DGB is in EBCDIC format (the format of the structured field and its content depend on the operating system on which the spooler is running), TrueProof will use the table `_Filter_E.CH5` (E for EBCDIC). If the job information is not in EBCDIC, it uses table `_Filter_O.CH5` (O for Other) to convert the job information. These two tables can also be used to replace undesirable or invalid characters in path names. The tables already contain mapping entries for replacing space characters, colons and backslashes.

<table>
<thead>
<tr>
<th>Table</th>
<th>Source format</th>
<th>Destination format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ebcdic.chs</td>
<td>EBCDIC</td>
<td>ASCII</td>
</tr>
<tr>
<td>Iso_ger.chs</td>
<td>ISO German</td>
<td>ASCII</td>
</tr>
<tr>
<td>Lcds.chs</td>
<td>Xerox LCDS</td>
<td>ASCII</td>
</tr>
</tbody>
</table>
3.1.6 Configuration of the Mail Service

In this version you can convert the output images into the formats PostScript/PDF and PCL. You need additional licenses for these formats. After printing you can deliver these files via ftp, lpr or mail. See also: 'Setup' -> 'Configuration' -> 'Output-Modules'.

Unlike the lpr and ftp commands, which are available by default under Windows, there is no mail service. To send mail you need a mail program with command line interface. This is then called with the corresponding parameters. If you want to send a mail, TrueProof starts a batch file, which is located in the directory C:\SRA3\Converter\Plugin and has the name postprocess.bat. This file is called with the following parameters:

1. Control - Typ ( lpr/mail/ftp )
2. Outpath
3. Inpath
4. mail
5. ftp
6. lpr

You now have to enter in the fattened line in the mail program:

if "%1" == "ftp" goto ftp
if "%1" == "lpr" goto lpr
if "%1" == "mail" rem <own mail programm>.. %2 .. %4

goto done:
:lpr
if "%6" == "NULL" lpr -S %5 -P standard -o l %2
if not "%6" == "NULL" lpr -S %5 -P %6 -o l %2

goto done:
:ftp
ftp2 %2 %5 %6 %4
:done
3.2 Functions of the Océ TrueProof

3.2.1 TrueProof Converter window

To work with Océ TrueProof, you first have to launch the TrueProof Converter. If you wish to keep track of the boot procedure, you can launch the TrueProof Converter window. The window is automatically presented as an icon (in minimised form) when you reboot the converter via the operator panel.

Notice: The converter window is placed as an icon in the task bar and must not be touched during productive operation. You should only activate (i.e. maximise) it for test and service purposes.

Keep a lookout for any error messages in the output. The boot procedure is complete when the operator panel stop LED turns red and the channel LED turns green. The completion is indicated in the converter window by the entry "SI: Boot finished".

3.2.2 TrueProof Operator Panel

The TrueProof Operator Panel shows the status of TrueProof and provides functions for managing the program. The panel needs the Java runtime environment version 1.3.1. This is provided with the installation.

The operator panel is a separate program and communicates with the main TrueProof program (TrueProof Converter) via SNMP. This in effect means it can be installed on any computer in the network provided the SNMP protocol is used. However, no SNMP service need be installed on the computer on which the operator panel is installed.

The operator panel contains the following elements:
Title bar

The title bar displays the following information (from left to right):

- Name of this instance of the TrueProof Converter
- Name of the current setup
- Name of the program: "TrueProof Operator Panel"

You can change the name of the current virtual printer. To do so, locate and edit the following entry in the registry on the TrueProof device:

```
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\SNMP\Parameters\RFC1156Agent\sysName="EPI2"
```

Menu Bar

Via the menu bar you have access to all functions of the TrueProof operator panel, which are described in detail below.

Tool Bar

The tool bar offers 6 button. You can assign any function to these buttons. See also: 'Configuration of the Tool Bar' on page 73.

Display

The top line of the operator panel shows messages which are much the same as the ones you would see on a real printer. They indicate the status of the TrueProof Converter, for example, or the status of the connection to the converter. The second line is for messages output by the TrueProof program, for example the amount of space free in the archive.

If information, warnings or error messages are displayed in the alert table of the operator panel, a symbol appears on the right hand side of the display. Clicking on this symbol opens the alert table displaying the messages.
Control elements

Beneath the display are the 'Ready' and 'Stop' buttons, various LED displays and three channel switches (channels B and C are not available for Océ TrueProof).

'Ready' (green)  Go to "Ready" state and begin receiving data from the host. When TrueProof is in "Ready" state, the LED above the button turns green.

'Stop' (red)  Go to "Not Ready" state and halt the printer. When TrueProof is in "Not Ready" state, the LED above the button turns red.

'DtaRdy' (green)  Data Ready LED. This turns green when data is being transferred from the host (i.e. when data is ready for output).

'SysRst' (yellow)  System Restart LED. This LED turns yellow when a hard error occurs. You must reboot in order to continue.

'Ch A' (green)  Turn channel A on and off. The LED above the button turns green when the channel in question is enabled.

Status bar

The status bar indicates the progress of the data transfer by displaying the path and name of the file being generated. The display is updated every three seconds.

Short-cut menu

The short-cut menu gives you access to the entire menu system. Even if you have turned off the display of the menu bar, you can access the functions by right-clicking in the operator panel display or in the area with the control elements. You are shown the following menu:
3.2.3 'Converter' Menu

This menu provides the basic functions of Océ TrueProof.

<table>
<thead>
<tr>
<th>Connect</th>
<th>Open the 'Connection' dialog box</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exit</td>
<td></td>
</tr>
<tr>
<td>Down</td>
<td></td>
</tr>
<tr>
<td>Channel A</td>
<td></td>
</tr>
<tr>
<td>Channel B</td>
<td></td>
</tr>
<tr>
<td>Channel C</td>
<td></td>
</tr>
<tr>
<td>Roof</td>
<td></td>
</tr>
<tr>
<td>Stop</td>
<td></td>
</tr>
<tr>
<td>Exit Panel</td>
<td></td>
</tr>
</tbody>
</table>

The address 127.0.0.1 indicates that the TrueProof Converter is on the local PC.

Use this dialog box to connect the operator panel temporarily with the TrueProof Converter on a different PC (which will enable you to make remote control settings). To do this, you enter the IP address of the computer in question in this field. The connection is valid for the duration of the program session – when you next launch the operator panel, the original IP address will be retrieved from the start parameters.
### Functions of the Océ TrueProof

**Working with Océ TrueProof (Windows)**

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
</table>
| 'Boot'   | Opens the 'Boot' dialog box:  

![Boot Dialog Box]

Use this dialog box to boot the system. You need to do this in order to start the system and to effect changes to certain system parameters.  
**Note:** If no active network is connected to the computer, mostly TrueProof cannot start. This is due to Windows 2000 disabling the network protocol if no network cable is attached to the computer. See appendix, page 93, for more information to get rid of this "feature".  
You can change the values for the Emulation, Functional Code Version and Resolution.  
In the IPDS mode you can also select resolution 'Auto' in this dialog box. This means, that all printer data streams (240, 300 or 600dpi) will be accepted. Additionally you can set the simulation mode in this window: 'VarioStream' for continuous printing or 'VarioPrint' for cut-sheet printing. The selection effects some settings in TrueProof. You can also change the emulation under 'Configuration' -> 'Device Type'. This dialog allows you also to make special settings for cut-sheet printers like the number of input bins. |
| 'Down'   | Shuts down the printer software. The TrueProof Operator Panel remains open. |
| 'Channel A' | The entries are greyed out. Channel A is activate by default. |
| 'Channel B' |  |
| 'Channel C' |  |
| 'Ready/Stop' | Switches the printer to 'Ready' or 'Stop'. Various output settings – such as changes to paper format settings – can only be made when device is at stop state. No data can be received while Océ TrueProof is in stop state. |
| 'Exit Panel' | Closes the TrueProof Operator Panel.  
**Important:** this does not end the TrueProof Converter. |
3.2.4 'Setup' Menu

Use the commands in the 'Setup' menu to load, create and delete printer settings and configure parameters. The defaults for Paper, Channel, Setup and Filing Structure are made with the commands in this menu. To change settings, you must first boot the converter and set TrueProof to 'Not Ready' state. Once defined, the settings can be stored in a setup with the name of your choice.

‘Load...’ Opens a window with a list of the setups available on the system. You can add your own setups to this list and assign them names of your choice (see ‘Save as...’):

‘Load’ loads the values stored in the selected setup. If you have not yet saved the current TrueProof settings, you are prompted to do so before the new setup is loaded. To activate the new settings, you have to reboot the TrueProof Converter (‘Converter’ -> ‘Boot’). A message to this effect is shown on the display: ‘Press Boot to activate the new setup’.

‘Save’ Saves the current settings of the selected setup (i.e. the one now in use).
'Save as...' After configuring the printer, you can use this command to store the setup under a name of your choice (4 - 14 characters):

To enter a brief description of the setup, click 'Edit'. This opens another dialog box; enter your description and click 'Save Description' to confirm. You can then quit the 'Save Setup' dialog box with 'Cancel' if you just wish to save your changes to the description but discard any changes to the setup itself.
## Functions of the Océ TrueProof

<table>
<thead>
<tr>
<th>'Delete'</th>
<th>Use this command to delete a selected setup.</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Delete Setup Window" /></td>
<td><img src="image" alt="Delete Setup Window" /></td>
</tr>
</tbody>
</table>

Do not delete the current setup. This is shown in the first line as 'Current Setup'.

---

[Image: A29247-X28-X-5-7670]
3.2.5 'Configuration' Menu

Use this command to make settings for the paper, emulation, paths and to determine how print pages will be handled:

- Load...
- Save
- Save as...
- Delete...
- Paper Size...
- Channel, Emulator...
- Device Type...
- Clipping...
- Test Filter...
- Separation...
- Output Modules...
- Converter Preferences...

3.2.5.1 'Paper Size...' 

Use this command to define the size of the physical medium on which the functional code is to place the logical pages from the data stream. The page size is equivalent to the values supported by the printer in question.

When converting the pages to bitmap format, the functional code follows certain rules for placing the logical pages on the physical medium. Consequently, you can choose to have the pages rotated automatically on the physical medium. The TrueProof rotation is exactly equivalent to the rotation performed on a real printer, and is determined by the settings you make in this dialog box.

Depending on the functional code you selected when booting the converter - either 'Vario-Print' for cutsheet printing or 'VarioStream' for continuous forms printing - different windows for setting the paper size will be opened.
Settings for continuous forms printing
Functions of the Océ TrueProof

Working with Océ TrueProof (Windows)

'Tractor Holes'
The range of valid paper sizes depends on the setting you make for the paper form. For 'Tractor Holes', choose either 'Pinless' or 'Pinfeed'. Océ high performance printers have different maximum paper widths for the two modes, and different rasters for setting the paper length.

<table>
<thead>
<tr>
<th>Paper form</th>
<th>Pinfeed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max. paper width:</td>
<td>18.25 in / 463.6 mm</td>
</tr>
<tr>
<td>Max. print width:</td>
<td>17.25 in / 438.2 mm</td>
</tr>
<tr>
<td>Max. paper length:</td>
<td>27 in / 685.8 mm</td>
</tr>
<tr>
<td>Rounded to:</td>
<td>1/6 inch</td>
</tr>
</tbody>
</table>

Paper form Pinless

Max. paper width: 18.25 in / 463.6 mm
Max. print width: 18.25 in / 463.6 mm
Max. paper length: 27 in / 685.8 mm
Rounded to: 1/60 inch

The maximum rounding values depend on the resolution (at 600 dpi max. 0.3 mm).
You can make settings in mm, inch or pels.
If you switch from 'Pinless' to 'Pinfeed' the values are rounded to the stricter threshold values and rasters. You are informed that values are being rounded.

Important: you must reboot the converter after switching from pinless to pinfeed or vice versa ('Converter' -> 'Boot').

'Default Formats'
Opens a drop down list, which allows you to select a default paper format. If you press the 'Use' button, the values will be transferred to the corresponding fields and the preview will be updated. If the values exceed the possible area, a warning is displayed informing you how the values will be cut.

'Paper width'
Set paper width.
Pinless and pinfeed printers work with different printable widths (see Tractor holes).

'Print width'
This field displays the printable width. You can update (refresh) the value by clicking "Apply".

'Paper length'
The increments for the paper length differ depending on whether the printer is pinless or pinfeed (see Tractor holes).

'Apply' / 'OK'
Click 'Apply' to apply the values. The display space then shows the paper width in inches (decimal) and the paper length in units of 1/60 or 1/6 inches (depending on the paper form setting).
Click 'OK' to confirm the settings and close the dialog box.
### Settings for cutsheet printing

The left half of the window illustrates the available input bins of the simulated cutsheet printer (configurable under 'Configuration' -> 'Device Type'). You can select each bin with a mouse click. If you have configured more than four bins, you can move to the next set of bins using the arrow button underneath the display of the bins. If a bin is selected, you can apply the desired settings using the four tabs on the right side of the window.

The first bin is in the image above the **default bin**. You cannot assign tabs to this bin. If you want to define another bin as default bin, you have to click on the LED. A LED, which lights up green, indicates the default bin.

| **Input Bins** | The left half of the window illustrates the available input bins of the simulated cutsheet printer (configurable under 'Configuration' -> 'Device Type'). You can select each bin with a mouse click. If you have configured more than four bins, you can move to the next set of bins using the arrow button underneath the display of the bins. If a bin is selected, you can apply the desired settings using the four tabs on the right side of the window. The first bin is in the image above the **default bin**. You cannot assign tabs to this bin. If you want to define another bin as default bin, you have to click on the LED. A LED, which lights up green, indicates the default bin. |
| **General** | On this tab you can define a bin name and assign a paper, which should be used in this bin. If you select 'Resizable', the format of the paper can be adjusted on the paper tab. |
| **Paper** | With 'Resizable' selected on the 'General' tab set paper width and height and orientation. |
| **Shift** | Enter the shift values for the printed image on the sheet. You can also adjust the values for the back page. |
| **Preprinted Form** | Select a form, which you have stored before on the system. If you activate the check box 'Activate the form', this form will be used for the input bin selected. |
### 3.2.5.2 'Paper Shift...'

![Shift dialog box](image)

<table>
<thead>
<tr>
<th>Two-Up Mode</th>
<th>Switch cutsheet emulation (CSE) on or off.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Two-Up Order</td>
<td>Here you define in which order and in which direction the pages are positioned on the print page when using CSE.</td>
</tr>
<tr>
<td>Shift Right Page</td>
<td>With CSE you can shift the right page independently from the left page.</td>
</tr>
<tr>
<td>Horizontal / Vertical Shift</td>
<td>Adjust the shift values to fine-tune the placement of the print image on the page</td>
</tr>
</tbody>
</table>
3.2.5.3 'Channel, Emulation...'

Use this dialog box to define the basic parameters for the printer that TrueProof is to simulate: the printer language (or emulation) and resolution. You can also set most of the values in 'Converter' -> 'Boot'.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>'Active Emulation'</td>
<td>Tells you which emulation, functional code version and resolution are now active.</td>
</tr>
<tr>
<td>'Channel'</td>
<td>The channel to which the dialog box settings apply. TrueProof has only one channel available, channel A.</td>
</tr>
<tr>
<td>'Type'</td>
<td>The type of interface to which the selected channel is attached. This is always TCP/IP with Océ TrueProof.</td>
</tr>
<tr>
<td>'Emulation'</td>
<td>The printer language in which TrueProof is to process print data (at the moment I-Mode only).</td>
</tr>
<tr>
<td>'Version'</td>
<td>If you have several functional codes installed, you can select the version you want to use. An asterisk preceding an entry indicates the emulation which was last booted and is now active; a plus symbol indicates the emulation which was used prior to the current one.</td>
</tr>
<tr>
<td>'Resolution'</td>
<td>Select the resolution of the simulated printing system. In I mode you can choose between 240 dpi, 300 dpi and 600 dpi. If you select 'Auto', all data streams (240, 300 and 600 dpi) will be accepted. Rasterization and output will always be in 600 dpi (Software MRM). Therefore the size of the files generated are bigger and the throughput of the data lower as if e.g. a 300 dpi data stream is imported with the setting '300 dpi'.</td>
</tr>
</tbody>
</table>
Notice: You can only set a channel emulation after deactivating the channel. The change takes effect the next time you enable the channel concerned. You are then prompted to reboot the system ('Press boot to activate changes') with the channel enabled. If the system is booted without a channel being selected, the most recent settings are used.
### 3.2.5.4 Device Type...

Allows you to select fanfold (VarioStream) or a cutsheet (VarioPrint) printer as device type.

<table>
<thead>
<tr>
<th>Cutsheet Options</th>
<th>Switch on or off 'CustomTone' and 'Duplex' mode. Additionally you can configure up to 16 input bins for the cutsheet printer.</th>
</tr>
</thead>
</table>
3.2.5.5 'Clipping...'

Use this dialog box to define what portion of the page will be saved to the TIFF file. Note the difference between this setting and 'Paper Size': the latter defines the size of the bit-mapped print image to be created by the functional code.

- 'Manual': If you select "Manual", you can set the coordinates of the clipped section in the "X-Offset" to "Height" fields. The section that comes within these coordinates is saved to the TIFF file.

- 'Auto (Page Size)': The section is the same size as the printable area defined for the paper size. This ensures the entire printable area is presented in the TIFF file. As a rule, this is the option you should use.

- 'Auto (Partition Size)'. The first logical page (partition) is saved to the TIFF file. Since the coordinates of the logical page are defined in the data stream, you can define a different section to clip on each page. This option is helpful when your jobs use a variety of formats. Set the paper size large enough to accommodate every format. The option "Auto (Partition Size)" will use the logical page sizes defined in the data stream. Overlapping areas will be truncated.

This function will only work if the logical pages are actually defined correctly in the data stream. Please verify that this is the case by previewing the resulting TIFF files.

- 'Page Resolution': Displays the current resolution setting.

- 'RecNo': No function

- 'Clip Resolution': No function
3.2.5.6 ’Text Filter...’

Define in this dialog, which text information is to be extracted.

| 'X-Offset' | When you have set “Clipping” to “Manual”, use this field to enter the offset to the left margin. Negative values are permitted (these enable you to offset to the marker column). |
| 'Y-Offset' | When you have set “Clipping” to “Manual”, use this field to enter the offset to the top margin. |
| 'Width' | When you have set “Clipping” to “Manual”, use this field to enter the width of the section to be clipped. |
| 'Height' | When you have set “Clipping” to “Manual”, use this field to enter the length of the section to be clipped. |
| 'Units' | Choose the measuring unit for the above settings: ‘mm’, ‘PEL’ or ‘inch’. |
| <Clipped section> | Presents the section as it would be with the present values. |

NormalText

The normal continuous text of the documents will be placed in the index files. In IPDS, this is the text created with Write Text controls. In PCL this is the text that is not part of an escape sequence. It is advisable to turn off normal text if you are transferring index data in Noop containers. This reduces the volume of data.
### Functions of the Océ TrueProof

**Horiz. Move as Space**
Interword and intercharacter spacing can be presented in PCL by space characters or by horizontal positioning commands. Check this option in order to replace the horizontal Move commands by space characters. This creates word delimiters that can be interpreted in normal text indices. Positioning commands are ignored if the option is left unchecked.

**Text from Noop-Control Sequences**
Index data can be embedded in Noop commands. The data is then present in the data stream but will not be printed and does not appear in the TIFF files. Check this option if you wish to have the text from Noop commands become part of the index data.

**Mark Noop-Control Sequences**
Check this option to frame text from Noop commands with "#NOP-Start" and "#NOP End". This enables the Noops to be identified if you select "Normal Text" for the indices in addition to Noop.

**Text from Barcode (only IPDS)**
Check this option to have the content of BCOCA commands made part of the index. This option is for IPDS only. There is no equivalent command in PCL for creating barcode.

**Mark Barcode-Control Sequences**
Check this option to frame text from Barcode strings with "#BARCODE-Start" and "#BARCODE End". This enables the Barcodes to be identified if you select "Normal Text" for the indices in addition to Barcode.

**Page IDs (only IPDS)**
Check this option to generate page IDs. These numbers are unique page identifications. In IPDS they are created by the host application or the spooler. In most cases they are also used to identify pages when parts of jobs are reprinted or reset (repositioned). In PCL the numbers are created by the controller. They are not used for reprints or repositioning as they are no longer unique by the time the reprint is performed.

**Device-Information**
Adds information on the selected device type at the beginning of the index text.
**Functions of the Océ TrueProof**

**Separation**

Use the options in this dialog box to define the events that will cause Océ TrueProof to execute a job separation command. Depending on the settings in the ‘Output Modules’ dialog box, TrueProof will place each job in a separate folder.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>'max. No of Pages'</td>
<td>Check this option in order to divide large print jobs into multiple folders containing a defined number of files. On some systems, this setting will improve post-processing. When the number of files in the folder reaches the defined level, TrueProof closes the stack. Whatever you choose, make sure to include the variable <code>&quot;&lt;stackno&gt;&quot;</code> in your definitions of the paths for the image files. If you fail to do so, TrueProof will report that the file does not exist because the page count is reset to 1 for each new stack.</td>
</tr>
<tr>
<td>'After Seconds'</td>
<td>Define a period of time, after which the job is separated.</td>
</tr>
<tr>
<td>'by Edge Marks'</td>
<td>Edge marks are markers that are printed across the folds of continuous forms. They are visible on the stacked forms, enabling operators to distinguish job transitions without fanning out the stack. The marks consist of one, two or three bars. At each change in the number of bars, TrueProof will begin a new job.</td>
</tr>
<tr>
<td>'by Alternate Offset Stacker'</td>
<td>This command performs a lateral offset of the stack in the output tray, enabling operators to identify and remove jobs more easily. When the command appears in the print data stream, TrueProof will begin a new job.</td>
</tr>
<tr>
<td>'by Mark Forms (only IPDS)'</td>
<td>These marks are usually wide strips composed of asterisks which are printed across the folds of continuous forms, enabling operators to distinguish job transitions without fanning out the stack. When the command appears in the print data stream, TrueProof will begin a new job.</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>'by Stack Received Pages (only IPDS)'</td>
<td>This is an IPDS command that causes the printer to convey all the pages it has so far produced to the stacker. When the command appears in the print data stream, TrueProof will close the current job.</td>
</tr>
<tr>
<td>'by Reset Printer (only PCL)'</td>
<td>Equivalent to the PCL “Escape-E” command. This is normally used at the beginning of jobs. However, whether or not the command occurs will depend on the application and printer driver. We have also seen the command used to begin pages or end jobs. With the default setting, ImageStream will begin a new job. The action can be defined in the CFG file (entry “FltJbM” in the key “SepMode_RstPrn”). The possible actions are listed in the appendix.</td>
</tr>
<tr>
<td>'by Universal Exit Language (only PCL)'</td>
<td>UEL, short for Universal Exit Language, normally indicates the end of a job. However, whether or not the command occurs will depend on the application and printer driver. We have also seen the command used to end jobs. With the default setting, ImageStream will close the current job. The action can be defined in the CFG file (entry “FltJbM” in the key “SepMode_UEL”). The possible actions are described in the appendix.</td>
</tr>
<tr>
<td>'by Host Signaled-Events'</td>
<td>‘Host-Events’ represent here IPDS Structured Fields ‘XOH Define Group Boundary’ in the printer datastream, which contain information on the job (see appendix A4). If the contents of this field is modified, a new job will be started. This may cause, that e.g. header and trailer pages are stored in different directories. This function allows you to switch off such a job separation. But you have to be aware that in this case the usage of job information in the pathnames (like &lt;jobid&gt; or &lt;jobname&gt;), see appendix A4) is not significant anymore.</td>
</tr>
</tbody>
</table>
3.2.5.7 Job and Stack Separation in Detail

Spooler Pages

Most spooling systems (and printer drivers also) can automatically generate pages that "bracket off" print jobs. This feature makes it possible to identify clearly where one job ends and the next one starts. We call these pages header and trailer pages.

The occurrence of an error during printing usually also causes pages to be generated – the pages, the message pages, provide detailed information about the error(s).

Some systems also make use of separator pages – for instance, to separate multiple copies of the same job. These pages are printed between the copies.

Commands in IPDS

In IPDS, you are most likely to meet the following commands in connection with header and trailer pages. Imagestream identifies these commands and uses them to structure the data for the archive.

- Control Edge Marks (XOA CEM) create between one and three small bars which are printed across the paper fold.
- Alternate Offset Stacker (XOA AOS) shifts the stack in the printer output tray. AOS is designed for cut sheet printers, and CEM for continuous-feed printers. Both commands are interpreted correctly for the type of printer in question.
- Mark Form (XOA MF) creates a thick bar, usually consisting of print lines with asterisk characters, which is printed across the paper fold.
- Define Group Boundary (XOH DGB) defines a sequence of pages as a group. Imagestream interprets this command by making the print job into a group.

Imagestream is configured right from the start to interpret these commands in an appropriate manner and create the right job and stack transitions.

PCL commands

Imagestream can identify the following PCL commands. Depending on how you configure the system, the commands can be interpreted either as the start of a print job or of a stack:

- Universal Exit Language
- Reset Printer
- Job separation commands

The spooler can be configured to generate these commands, or they can be embedded in the PCL print data that the spooler receives. Details are provided in the appendix.
NPRO pages

The IPDS command Stack Received Pages (XOH SRP) is used to convey all the pages currently being processed by the printer to the stacker. When you are working with a continuous feed printer, this is how the spooler ensures that every single page has in fact been conveyed through the fusing station and placed in the stacker. What the command does is to instruct the continuous feed printer to generate enough blank pages – NPRO or Non Process Run Out pages – to eject the printed pages to the stacker.

Imagstream can identify and omit NPRO pages or other pages generated by the functional code. These pages are not stored, but can serve as criteria to mark the closure of the job.

Text recognition

The Imagstream filter can be configured to begin a new job on the basis of simple text recognition. This setting is made in the configuration file. The text recognition feature permits constant text strings and is performed after the characters in the index data are converted. You can define one text for ending a job and another for beginning a job.

If your environment works with header and trailer pages, you can also use these pages to separate jobs. It is useful to have the trailer page indicate the end of a job to Imagstream, because the job is closed immediately following the last page – rather than waiting until the first page of the next job is received.

Timer-controlled actions

On some systems TrueProof can only identify the start of a job, and not the end. This is fine as long as there is a steady stream of jobs arriving. However, when it comes to the last print job in a series, this job will not be finished for a long time. Post processings like lp will not be performed. To avoid this problem, you should always try to complete jobs with a job end control.

If this is not possible, Imagstream can be instructed to close the job or stack after a defined time has elapsed since the arrival of the most recent page. Choose a long enough time – at least one minute – to prevent jobs being inadvertently truncated in the event of a normal slowdown in processing.

This function is no more than a workaround, and you should certainly attempt to close the job on the basis of other criteria in the print data (see ‘Structure of the Input Data’ on page 2).
User-triggered actions

You can use the Output -> Close current Job... command on the operator panel to close the preceding print job and begin a new one. This action has no impact on the state of the print job on the host or print server; it merely alters the internal Imagestream variables and causes the subsequent print pages to be stored in a different path. However, the action is seen as if a real job change had taken place.

The Output -> Start new Job... command begins a new job without closing the preceding one for post-processing. This feature is useful for executing a restart following a job with errors. The post process will not be started.
3.2.5.8 Output Modules...

From version 2.0 you can convert the datastream also to the formats PS/PDF and PCL. These converters are protected by licences. If the necessary licenses are installed, you can see additional tabs for every converter under 'Setup' -> 'Output Modules'. If the tabs are not visible although licenses are installed, you can verify if the licences are valid using the 'showlic' command.

As described above, the output modules are used to convert the datastream into the formats PS/PDF and PCL. This is done by converting the input data into bitmaps to which only a PostScript/PDF/PCL frame is added. Therefore the jobs of the corresponding formats are exactly the same copy of the data which the printer would print or which you see in the viewing system. After conversion the data are saved on the local harddisk. You can use TrueProof variables to create paths (for details see

Additionally you can define on these tabs in which way the files are to be processed after conversion. Postprocessing commands can be 'lpr', 'ftp' or 'mail'. The corresponding tabs can be set on the tabs.
Working with Océ TrueProof (Windows)

Functions of the Océ TrueProof

**Internal variables**

The values are generated by TrueProof and have no relation to job numbers or names, generated on the host or spool system.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Function</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;winno&gt;</td>
<td>Number of clipped section</td>
<td>Always 1, currently. Would be relevant with N-UP applications</td>
</tr>
</tbody>
</table>
### Functions of the Océ TrueProof

#### Working with Océ TrueProof (Windows)

You can generate jobs manually or using job separation commands. Use the ‘Separation’ dialog box (‘Setup’ -> ‘Configuration’ -> ‘Separation’) to define the events that are to cause TrueProof to separate jobs. The separation increments the variable `<jobno>`; Variables `<pageno>` and `<stackno>` are reset to 1.

If you check the ‘Max Number of Pages’ option in the ‘Separation’ dialog box, TrueProof will process this number of pages, then increment the variable `<stackno>` and reset `<pageno>` to 1. This makes it possible to partition a large job into stacks of a more manageable size.

**Important**: If you check the Max Number of Pages’ option, be sure to use the variable `<stackno>` in your part expression!

### Variable Function Remarks

<table>
<thead>
<tr>
<th>Variable</th>
<th>Function</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;jobno&gt;</code></td>
<td>Job number</td>
<td>You can generate jobs manually or using job separation commands.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Use the ‘Separation’ dialog box (‘Setup’ -&gt; ‘Configuration’ -&gt; ‘Separation’) to define the events that are to cause TrueProof to separate jobs. The separation increments the variable <code>&lt;jobno&gt;</code>; Variables <code>&lt;pageno&gt;</code> and <code>&lt;stackno&gt;</code> are reset to 1.</td>
</tr>
<tr>
<td><code>&lt;stackno&gt;</code></td>
<td>Stack number</td>
<td>If you check the ‘Max Number of Pages’ option in the ‘Separation’ dialog box, TrueProof will process this number of pages, then increment the variable <code>&lt;stackno&gt;</code> and reset <code>&lt;pageno&gt;</code> to 1. This makes it possible to partition a large job into stacks of a more manageable size. <strong>Important</strong>: If you check the Max Number of Pages’ option, be sure to use the variable <code>&lt;stackno&gt;</code> in your part expression!</td>
</tr>
<tr>
<td><code>&lt;pageno&gt;</code></td>
<td>Page number</td>
<td>Sequential page count.</td>
</tr>
<tr>
<td><code>&lt;seqno&gt;</code></td>
<td>Sequence number</td>
<td>This count is continued at the start of every new session with the TrueProof Converter (e.g. via ‘Converter’ -&gt; ‘Boot’).</td>
</tr>
<tr>
<td><code>&lt;year&gt;</code></td>
<td>4-digit year</td>
<td></td>
</tr>
<tr>
<td><code>&lt;month&gt;</code></td>
<td>2-digit month</td>
<td></td>
</tr>
<tr>
<td><code>&lt;dd&gt;</code></td>
<td>2-digit day</td>
<td></td>
</tr>
<tr>
<td><code>&lt;mmd&gt;</code></td>
<td>2-digit month and 2-digit day</td>
<td></td>
</tr>
<tr>
<td><code>&lt;yyyymmdd&gt;</code></td>
<td>2-digit year, 2-digit month and 2-digit day</td>
<td>Important! leading zeroes are truncated. Y2K dates are resolved incorrectly: 1.1.2000 becomes 101. Specify the date in the format <code>&lt;yyymmdd%6&gt;</code> to expand correctly to 000101</td>
</tr>
<tr>
<td><code>&lt;yyyyymmdd&gt;</code></td>
<td>4-digit year, 2-digit month and 2-digit day</td>
<td></td>
</tr>
</tbody>
</table>
### Job information from the print data stream

TrueProof takes the values for these variables from the print data stream. They are provided by the host or spooler. However, not all systems deliver all these variables.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Function</th>
<th>IPDS, Structured Field</th>
<th>XOH DGB:</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;JobName&gt;</td>
<td>Job Name</td>
<td>MVS and VSE: 8Byte</td>
<td>XOH DGB:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>VM: 8Byte</td>
<td>Job name (EBCDIC)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OS/400: 10Byte</td>
<td>File name of spool print file (EBCDIC)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AIX and OS/2: 15Byte</td>
<td>Job name (EBCDIC)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PCL:</td>
<td>The 1-251 character file name associated with the file being printed. (ASCII)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Any OS: 32Byte</td>
<td>In SPS: At the moment a single ASCII blank (0x20)</td>
</tr>
<tr>
<td>&lt;JobClass&gt;</td>
<td>Job class</td>
<td>MVS and VSE: 1Byte</td>
<td>XOH DGB:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>VM: 1Byte</td>
<td>Job class parameter (EBCDIC)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OS/400: -</td>
<td>Spool class value (EBCDIC)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AIX and OS/2: -</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PCL:</td>
<td>-</td>
</tr>
<tr>
<td>&lt;JobId&gt;</td>
<td>Job ID</td>
<td>MVS and VSE: 8Byte</td>
<td>XOH DGB:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>VM: 8Byte</td>
<td>Job identification (EBCDIC)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OS/400: 10Byte</td>
<td>Spool identification number (Spool ID)(EBCDIC)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AIX and OS/2: -</td>
<td>Job number (EBCDIC)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PCL:</td>
<td>-</td>
</tr>
<tr>
<td>&lt;FormId&gt;</td>
<td>Form ID</td>
<td>MVS and VSE: 8Byte</td>
<td>XOH DGB:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>VM: 8Byte</td>
<td>FORMS parameter (EBCDIC)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OS/400: 10Byte</td>
<td>Spool formname value (EBCDIC)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AIX and OS/2: -</td>
<td>Forms name (EBCDIC)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PCL:</td>
<td>-</td>
</tr>
</tbody>
</table>
### Functions of the Océ TrueProof

**Working with Océ TrueProof (Windows)**

Fields that are left undefined are assigned the following defaults:

- `<JobName>`: NoJobNme
- `<JobId>`: NoJobId
- `<FormId>`: NoFormId
- `<UserId>`: NoUserId
- `<HostPageId>`: 0
- `<JobClass>`: Z

**Notice:** Variables are not case-sensitive; `<jobclass>` and `<JobClass>` are equally valid.

If a variable contains just underscore characters, this means the field is defined but the spooler has padded it with blanks instead of assigning a real value. TrueProof converts the space characters to underscores using the code mapping table `_Filter_E.CHS`.

You can modify the path variables using the following operator:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Function</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>%</code></td>
<td>Number of places</td>
<td><code>&lt;pageno%4&gt;</code> provides the last four digits of the page number. This operator should always precede the <code>&gt;</code>, otherwise the system would remove the leading zeroes (in some cases this might be the desired effect).?</td>
</tr>
</tbody>
</table>
3.2.5.9 ‘Converter Preferences...’

Use this dialog box to set general preferences for the TrueProof Converter.

<table>
<thead>
<tr>
<th>'TrueProof Logfile-Path'</th>
<th>The path in which the log files are to be created. You can also modify the naming scheme of the logs here. The following TrueProof variables are not permitted here: &lt;stackno&gt;, &lt;pageno&gt; and &lt;cutno&gt;. Further information about the variable portions of names is provided in the appendix.</th>
</tr>
</thead>
<tbody>
<tr>
<td>LogLevel</td>
<td>Defines the level of detail in the log files. With LogLevel 0 no entries are made in the file. You should not set levels below 31, since otherwise TrueProof will suppress the output of error messages or warnings that are vital for troubleshooting.</td>
</tr>
<tr>
<td>Autostart [ms]</td>
<td>A value greater than 0 will cause the TrueProof Converter to boot automatically after the specified time. You enter the time in msec. The count begins when the SNMP service is started. A useful value is 20000 ms (i.e. 20 seconds after the start of the SNMP service).</td>
</tr>
<tr>
<td>Auto-Ready [ms]</td>
<td>If the value here is greater 0, the TrueProof converter automatically changes to ‘Ready’ after the period of time indicated. The period is set in milliseconds and starts at the end of the boot procedure.</td>
</tr>
</tbody>
</table>

**Notice:** Changes to log settings do not take effect until you next launch TrueProof.
3.2.6 'View' Menu

The View menu contains commands for opening the TrueProof Viewer, requesting certain information and customizing the appearance of the operator panel.

<table>
<thead>
<tr>
<th>'Output...'</th>
<th>Launches the database browser.</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Database Browser" /></td>
<td></td>
</tr>
</tbody>
</table>

Here you can view the printed documents, save them as file or resource or delete them. To open a pop up menu with corresponding commands, click on a document with the right mouse button.
## Functions of the Océ TrueProof

<table>
<thead>
<tr>
<th>‘Alerts...’</th>
<th>Outputs information about the system, messages and versions:</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Alerts List" /></td>
<td>The alert list – which lists errors and messages – tells you the current status of TrueProof. Once a problem is corrected, its message disappears from the list.</td>
</tr>
<tr>
<td><strong>Notice:</strong></td>
<td>'Display information changed' is a normal entry and its number is incremented by 1 each time the display changes.</td>
</tr>
<tr>
<td></td>
<td>Some problems (e.g. 'File already exists') can only be resolved by rebooting the system.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>‘System Into...’</th>
<th>Like ‘Alert’, but the list contains system information that is primarily of use for reporting to service engineers in order to help correct errors.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>‘Menubar, Toolbar, Statusbar’</th>
<th>You can toggle the display of the menu, toolbar and status bar on and off. With the default setting, the menu and status bars are turned on. You can select the ‘hidden’ elements by right-clicking in the operator panel window.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Notice:</strong> The tool bar is provided merely for reasons of compatibility with the predecessor. No further development work has been done on it.</td>
</tr>
</tbody>
</table>
### 3.2.7 'Output' Menu

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>'Start new Job...'</td>
<td>Starts a new job without closing the previous one for a post processing (lp, ftp), which is probably set. The action is independent of the status of a print job on the host or print-server. It only influences the internal variables of TrueProof and therefore the storage path of the following print pages. You can use this function e.g. to restart an erroneous print job.</td>
</tr>
<tr>
<td>'Close current Job...'</td>
<td>When a job is in progress, the TrueProof Viewer never displays beyond the penultimate image file created by the converter, because it is unable to know whether the last file has already been completed. If a job is closed by means of commands embedded in the data stream (e.g. NPRO), the TrueProof Converter sends a command to the viewer, causing the viewer to read the last set of data and display the last page. If there is no NPRO, the creation of the control file can be triggered by 'Close current Job', i.e. the viewer will be able to display the last page even without commands in the data stream. <strong>Notice</strong>: you can only close the preceding job of the current session. After rebooting the converter you will not be able to close the last job of the preceding session.</td>
</tr>
</tbody>
</table>
3.2.8 'Options' Menu

<table>
<thead>
<tr>
<th>'Panel Preferences...'</th>
<th>Use this command to display the internal SNMP parameters. You cannot change any of the entries in the dialog box.</th>
</tr>
</thead>
<tbody>
<tr>
<td>'Always on top'</td>
<td>Check this option to keep the operator panel window in the foreground of your display.</td>
</tr>
</tbody>
</table>
‘Viewer Preferences...’

Use this dialog box to define the command to be executed when you choose 'View\Output'.

The placeholder <IP-ADDRESS> is replaced by the real IP address used to launch the operator panel. This ensures that the operator panel and viewer both address the same computer.

Notice: if the Viewer cache and TrueProof Converter are installed on different computers, you must enter the correct IP address or computer name in place of the <IP-ADDRESS>.

3.2.9 Help Menu (‘?’)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>‘Help’</td>
<td>Opens the help system.</td>
</tr>
<tr>
<td>‘About Panel’</td>
<td>Displays information about the panel.</td>
</tr>
<tr>
<td>‘Version Info’</td>
<td>Displays the version of the panel, converter and modules (like System Info).</td>
</tr>
</tbody>
</table>
3.3 Configuration of the Tool Bar

To configure the tool bar you have to edit the entries "ToolButtonText" and "ToolButtonFunction" in the "jBDF.ini" file. The buttons are numbered from 1 to 6, these numbers are simply appended to the entries.

With "ToolButtonText" define the text, which appears as button label. You can use up to 8 characters.

/ToolButtonText1=Boot
/ToolButtonText2=Load
/ToolButtonText3=PapSize
/ToolButtonText4=OutMod
/ToolButtonText5=Viewer
/ToolButtonText6=Down

With "ToolButtonFunction" define the function or dialog, with is to be called with this button.

/ToolButtonFunction1=102
/ToolButtonFunction2=201
/ToolButtonFunction3=205
/ToolButtonFunction4=212
/ToolButtonFunction5=301
/ToolButtonFunction6=103

List of valid IDs:

Menu "Converter"

----------
101: Connect...
102: Boot...
103: Down...
104: Channel A
105: Channel B
106: Channel C
107: Ready
108: Stop
109: Exit Panel
Configuration of the Tool Bar

Menu "Setup"
-------------
201: Load...
202: Save
203: Save as...
204: Delete...
205: Configuration\Paper Size...
206: Configuration\Paper Shift...
207: Configuration\Channel, Emulation...
209: Configuration\Clipping...
211: Configuration\Separation...
212: Configuration\Output Modules...
213: Configuration\Converter Preferences...

Menu "View"
----------
301: Output...
302: Alerts...
303: SystemInfo...
304: Menubar
305: Toolbar
306: Statusbar

Menu "Output"
-------------
401: Start new Job...
402: Close Current Job...

Menu "Options"
------------
501: Panel Preferences...
502: Always on top
503: Viewer Preferences...

Menu "?"
--------
601: Help...
602: About Panel...
603: Version Info...
4 TrueProof Cache Browser

TrueProof administretes the processed data in a cache, which can be accessed by the TrueProof viewer and the TrueProof cache browser over the entire network. To achieve this you have to enter the IP address of the cache browser in the 'Server' field of the cache browser user interface. Normally the cache browser is located on the TrueProof server. Access is possible via Windows or Linux. Select 'Setup' -> 'Configuration' -> 'Separation' to define which pages should be combined for a document.

You can use the TrueProof cache browser to

- view saved jobs
- to start the viewer with the corresponding job
- to delete jobs
- exclude jobs from the automatic deletion of jobs
- generate forms from printed data
- assign different form names to forms/change form names
- set the TrueProof cache size
- search documents with keywords
- make additional settings.
You start the browser via the operator panel clicking the menu 'View' -> 'Output'. All printed data will be stored in the cache, if it's active.

4.1 View stored jobs

On the tab 'All documents' you can see all jobs, which have been printed in TrueProof. The names of the documents depend on the settings under 'Setup' -> 'Configuration' -> 'OutputModules'.

4.2 Start the viewer with a corresponding job

Double clicking a job starts the viewer with the corresponding job.

4.3 Start the viewer in the continuous mode

If you click the 'Continuous Mode' button, the viewer is started in this mode, i.e. the currently processed jobs are immediately displayed in the viewer.

4.4 Deletion of documents

If you mark a document and click on it with the right mouse button, a context menu pops up where you can select 'Delete Document...'.

4.5 Generation of forms

You can only generate forms from documents, which are already stored as documents in the TrueProof cache. There are two possibilities to save print data in the cache:

- Printing into the cache
- Importing external documents

You can import bilevel tiff files directly into the TrueProof cache. To do this select the 'File' menu and click on 'Import Form ...'.

There are two different types of forms:

- Simplex forms
- Duplex forms

You can manage both types with the context menu. If you click on the cross before each document, all pages within this document will be displayed. Mark one of these pages. If you click on it with the right mouse button, a context menu pops up which allows you to save the page as a simplex form.
If you want to define a duplex form, you have to mark exactly two pages of a document. The context menu now offers the possibility to save a duplex form:

4.6 Assign different form names to forms/change form names

To assign different names to forms, which will be displayed in the paper size dialog, move to the 'Resource documents' dialog. All defined forms are displayed in this window. Click on the form name you want to change. After 2 seconds the field becomes editable. Click <RETURN> to accept the changes.

4.7 Deleting forms

To delete a form, you have to mark it. Click <DEL> to delete it.
4.8 Searching for Keywords

To be able to search for keywords, you have to define the correct charset for the language under 'Setup' -> 'Configuration' -> 'Textfilter'.

Having done this you can search for defined terms by entering their name in the 'Find in index' field. The display of the documents is updated after some time and the number of matches is displayed for every document. Documents which contain no matches are not displayed. The browser returns to the normal mode, if the entry in the search field is deleted. In this version you cannot search for more than one term at the same time. Wildcards are also not allowed.
Working with the Océ TrueProof Viewer (Windows)

5 Working with the Océ TrueProof Viewer (Windows)

First open the TrueProof Cache Browser clicking the menu 'View' -> 'Output' in the TrueProof operating panel. Now you can see an overview of all currently printed documents. With a double click you can open documents or pages within a document in the TrueProof Viewer.
5.1 Main Window

The main window consists of four different areas: page area, thumbnail area, navigator area and a menu and tool bar.

5.1.1 Using the Page Area

The page area displays the page contents. The visual appearance of the page contents is affected by a number of options:

The scrollbars, and, if supported by your mouse and your operating system, by the mouse wheel, can be used to move around in the current page. In addition, you can move around in the page by left-dragging the page contents.

To zoom in the page use the right mouse button to select the area you are interested in. To zoom out again click right in the area.

5.1.2 Using the Thumbnail Area

![Thumbnail Area Diagram]

The thumbnail area contains small images ("thumbnails") of the document pages. This way you can easily have an oversight over the document's contents. You can scroll through the document by means of the scrollbar. To bring a page of the document to display you simply have to double click the pages thumbnail.

The thumbnail area is a docked window. That means you can dock the window in and undock it from the viewer window.

**Note:** Whether or not the thumbnails do contain visual contents can be changed in the Thumbnail Options dialog. This dialog allows you to define the thumbnails' size as well.
5.1.3 Using the Navigator Area

The navigator area contains a small overview over the current page. It can be used to move around on the page, which is especially useful when working zoomed in the page.

To move to a certain area in the page, click on the area in the navigator view. The page display will then move to this area.

5.1.4 Using docking windows

The Thumbnail Area, the Navigator Area, and the several Toolbar sections are implemented as so-called dockable windows. These are windows that can be, and by default are, docked in the main application. However, one can undock these windows by dragging the window handle (which is on top or left of the window) out of the application window. To dock the window again, drop the window on the left or top side of the main window. By right-clicking in the toolbar or the navigator area these windows can be switched on or off.

By right-clicking in the toolbar or the navigator area these windows can be switched on or off:
## 5.1.5 Menu and Tool Bar Functions

### Menu File

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open File...</td>
<td>Opens a file selection box.</td>
</tr>
<tr>
<td>Exit</td>
<td>Exits the program.</td>
</tr>
<tr>
<td>Print Current Page</td>
<td>Prints the current page on the connected default printer.</td>
</tr>
<tr>
<td>Recently viewed Files</td>
<td>Displays a list of the files you have recently opened. You can easily reopen the file by clicking on it.</td>
</tr>
</tbody>
</table>

### Menu Zoom

<table>
<thead>
<tr>
<th>View</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal (100%)</td>
<td>This view corresponds to the original presentation of a document (100%).</td>
</tr>
<tr>
<td>Fit into Window</td>
<td>The view of the document is scaled up or down so that it fits into the main window both horizontally and vertically.</td>
</tr>
<tr>
<td>5% - 800%</td>
<td>Options for zooming up or down for an overall or detailed view of the print file.</td>
</tr>
</tbody>
</table>
## Menu Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Toggle Linecross</strong></td>
<td>Allows you to switch on and off the line cross.</td>
</tr>
<tr>
<td><strong>Units: pels</strong></td>
<td>When this toggle button is on, pels will be used as the unit of measure.</td>
</tr>
<tr>
<td><strong>Units: mm</strong></td>
<td>When this toggle button is on, millimeters will be used as the unit of measure.</td>
</tr>
<tr>
<td><strong>Units: inch</strong></td>
<td>When this toggle button is on, inches will be used as the unit of measure.</td>
</tr>
<tr>
<td><strong>Thumbnail Options...</strong></td>
<td>In this dialog the user can change some settings regarding the display of thumbnails:</td>
</tr>
<tr>
<td></td>
<td>If the &quot;Display Thumbnails&quot; box is checked the thumbnail contents will be displayed, otherwise only white pages will be shown.</td>
</tr>
<tr>
<td></td>
<td>Using the &quot;Adjust Thumbnail Size&quot; slider one can change the size of the thumbnails in the display.</td>
</tr>
<tr>
<td></td>
<td>The image above provides a preview of these settings.</td>
</tr>
<tr>
<td><strong>Continuous Mode</strong></td>
<td>Switches the viewer to continuous mode, i.e. all currently submitted print jobs are displayed in the viewer window as soon as the printing starts.</td>
</tr>
</tbody>
</table>
The Professional Document Viewer features a technology known as Antialiasing to improve image quality when displaying pages with a zoom less than 100%. This setting can be made in the toolbar or in the Options menu. Whilst antialiasing may greatly enhance the quality of the displayed page, this process consumes much more memory and processor resources than non-antialiased viewing, and is somewhat slower, which could make the viewer less responsive. Therefore one should decide which setting to use with this in mind.

For an example compare the two images below: Both images show the same part of a page at the same zoom rate. Obviously the non-antialiased image (left) has an image quality much worse than that on the right side.

Menu Help

<table>
<thead>
<tr>
<th>Contents'</th>
<th>Opens the PDV3 help.</th>
</tr>
</thead>
<tbody>
<tr>
<td>About...</td>
<td>Displays version info on PDV3.</td>
</tr>
<tr>
<td>About Modules...</td>
<td>Opens a list with path and version of the installed PDV3-Modules.</td>
</tr>
</tbody>
</table>
Toolbuttons

These buttons let you open a document, reload the current document, or print the current page.

These buttons let you select a page for display. The two buttons on the left activate the first resp. the previous page, while the two buttons on the right activate the next resp. the last page of the document. The text area let you directly specify the page number to view, and by pressing the third button you can easily select the page graphically.

Remember that a page can be selected in the thumbnail view as well.

These buttons have a visual effect only when viewing documents with Custom Tone (sometimes called "Spot Color" or "Highlight Color") layers. The two buttons on the left enable or disable the respective layer. By clicking on the small color areas one can define the color used for that specific layer. By using the buttons on the right side the order of the layers can be changed: A dot which is colored on top layer always overwrites a colored dot in the same position on the bottom layer.

These buttons can be used to change the zoom factor. They zoom in the page (the zoom factor is doubled), zoom out of the page (zoom factor is halved), set the zoom to normal (one pixel on the screen is one pixel in the page), or change the zoom factor in such a way, that the document fits horizontally or vertically in the window.

Please note that the zoom factor can be changed directly by using the mouse in the Page Area. To set the zoom factor to some fixed values the entries in the Zoom Menu can be used. Also note, that zoom factors are limited within 2 and 800 %.
These buttons can be used to enable or disable antialiasing.

These buttons can be used to enable or disable translucent pages. When enabled one you see not only the current page, but the backside of the page as well, displayed in a blue color.

However, the visual appearance of this changes depends on whether the document viewed is to be printed top to down or left to right. As most import modules do not support such information the user must set the correct mode by himself. This can be done by the "Duplex" and the "Tumble" setting.

To provide the same features for single sided papers a "Simplex" setting was added, added which lets you "look thru" the current page on the next one in your document.

5.2 Status Bar

The status bar provides the following information:

- Length and width of the current page (in the selected measuring unit)
- Page layout
- Zoom setting
- Coordinates of the mouse pointer on the current page, measured from the left and top page margins
- Total page count
6 Working with Océ TrueProof (PRISMAproduction)

6.1 Installing the TrueProof Viewer under PRISMAproduction

Generally, the TrueProof Viewer is installed together with PRISMAproduction, so it doesn’t have to be installed separately. However, the TrueProof CD could contain a newer version of the viewer. Proceed as follows to install this version:

1. Log on to the Linux system as user root.
2. Insert the TrueProof CD in the drive of the PRISMAproduction Server.
3. Open a terminal and mount the CD with `/mnt/cdrom`.
4. Change to the directory on the CD, which contains the RPM for the viewer:
   `cd /mnt/cdrom/Linux/Prisma/Viewer`.
5. Start the PRISMAproduction Installation Manager with `install.prisma`.
6. Type in `<1>` to execute an update from CD. In the second screen after this type in `<2>` for a package update and finally `<N>` to start the update process.

6.2 Installation of the Operator Panel

You can install the operator panel RPM as an update package in the way described above under 5.1. You only have to select a different directory on the CD from which the installation has to be started: `/Linux/Prisma/TP_OperatorPanel`. 
6.3 Configuring a TrueProof Printer on the Print Server

To process TrueProof jobs, a TrueProof printer has to be configured on the PRISMA print server as a fanfold printer.

The TrueProof printer is configured as a network printer with these settings:
- Port number: 5001
- Name of TrueProof printer: TrueProof_<hostname>
- Printer IP: IP address of TrueProof server
- Resolution: 240, 300, 600 dpi or Auto

The Océ TrueProof server must be entered in the file \etc\hosts on the print server, and the print server must be entered in the file \WINNT\system32\drivers\etc\hosts on the Océ TrueProof server.

To ensure all the pages of a TrueProof job are actually displayed, you must set an NPRO time of at least 00.00.04 for the printer in the spool administrator window.

6.4 Launching the Operator Panel

To launch the operator panel under Linux, open a shell and type in the following start command: /u/prismapro/lib/tp/bdf_linux. You can transfer the IP address of the TrueProof server to the program. If no parameters are transferred, you will be asked for the required IP address.

6.5 Launching Océ TrueProof Viewer via PJM

The Océ TrueProof Viewer is launched automatically with the print job on an Océ TrueProof printer.

In PRISMAproduction you can also launch the Océ TrueProof Viewer via the 'Utilities' menu in PJM. The system establishes a connection with the selected Océ TrueProof printer and displays the most recent job.

If no PJM is available, you can also launch the TrueProof Viewer via command line in a UNIX/LINUX terminal:

```
pdv -sp <ip-adr> oder
```

```
pdv -sp <hostname>
```
If you save this command as a user script in the directory `/u/prismapro/cfg/user-scripts`, the viewer will be started automatically.

6.6 Functions of the TrueProof Viewer

The functions of the TrueProof viewer under PRISMAproduction are almost identical to the functions of the viewer under Windows, which are described in the chapter before.
A Appendix

A.1 Disableing Media Sensing in Windows 2000

Introduced with Windows 2000 the newer versions of Windows contains the "Media Sensing" feature, detecting wheater your network media is in a link state.

When e.g. no network is attached to your ethernet adapter, the TCP/IP protocol is removed from that adapter.

In that state without bound TCP/IP protocol, TrueProof will not be able to boot properly. Mostly it will crash in an early bootstate. Anyhow you cannot go online. If you want to use TrueProof without a connected network, you'll have to switch off the "Media Sensing" in Windows. To do this, just start the file:

C:\Sra2\Istream\Tools\Misc\DisableMediaSense.reg

by double clicking on it and reboot the computer.

For more information read:

C:\Sra2\Istream\Tools\Misc\DisableMediaSense.txt.

Note: Disabling Media Sensing is mainly important when using TrueProof on a Laptop without network connections.
A.2 Working with Configuration Files

Path for storing configuration files

The TrueProof configuration data is stored in INI and CFG files (configuration files). The CFG files store settings that are specific to particular types or classes of jobs. The INI file stores device parameters and settings that determine the general responses and behaviour of TrueProof (i.e. the global settings that apply to every job class).

INI files are located in the folder C:\SRA3\PrnSetup\_Init and CFG files in the folder C:\SRA2\PrnSetup\ImageStream.

The SET files in the folder C:\SRA2\PrnSetup contain the descriptions of the configurations you can enter and edit via the operator panel menu with 'Setup' -> 'Save as...'. The subfolder "Init" contains these files

- 'Imagestream.ini'
  Stores all TrueProof-specific settings.

- 'Controller.ini'
  Stores the settings of the Functional Code.

- 'PrnSetup.ini'
  Stores the same of the current configuration (saved on operator panel with 'Setup' -> 'Load Setup' -> 'Current Setup').

- 'Controller.ll_' and 'Imagestream.ll_'
  These files are the working copies of the .ini files. This is where TrueProof stores the current settings. These files must not be changed.

Folder C:\SRA3\PrnSetup\Controller contains the configuration files that apply to the Functional Code settings, made with the commands 'Paper Size...', 'Paper Shift...' and 'Channel, Emulation...' in the 'Setup' -> 'Configuration' menu on the operator panel.

The file 'LastLoaded.cfg' is the working copy. This is where TrueProof saves the current settings. The file must not be changed.

Folder C:\SRA3\PrnSetup\Imagestream stores the configuration files that apply to settings of the TrueProof Converter, made with the commands 'Clipping...', 'Text Filter...', 'Separation...' and 'Filing Structure...' in the 'Setup' -> 'Configuration' menu on the operator panel.
Editing setup files

**Notice:** Create a copy of the directory `c:\Sra3\PrnSetup` for safety reasons and store it carefully. You should always backup this directory after important modifications in the setups.

1. Launch the TrueProof Converter ('Converter' -> 'Boot').
2. Save the setup to write the current settings to the configuration file ('Setup' -> 'Save').
3. Open file `C:\SRA3\PrnSetup\_INIT\*.ini` or `C:\SRA3\PrnSetup\ImageStream\<Setupname>.cfg` or `C:\SRA3\PrnSetup\Controller\<Setupname>.cfg` with Notepad. For `<Setupname>`, enter the name under which you stored the setup.
4. Make your changes, save the file and exit Notepad.
5. Load the edited setup on the operator panel with 'Setup' -> 'Load'.
6. Reboot the TrueProof Converter.
A.3 Troubleshooting

**TrueProof Operator Panel Does Not Start**

<table>
<thead>
<tr>
<th>Problem</th>
<th>The operator panel will not start.</th>
</tr>
</thead>
</table>
| Reason and corrective measures | No icon for TrueProof Operator Panel on your desktop:  
⇒ Create the icon again by defining a link on your desktop to "javaw.exe -classpath .;jBDF.jar com.oce.ops.bdf.is/BdfFrame 127.0.0.1".  

⇒ No reaction after double-clicking the operator panel icon:  
⇒ It takes a few seconds for the Java-programmed operator panel to launch. If the panel has not launched after 20 seconds, check that the Java Runtime Environment has been installed correctly. To do this, enter the following command in a DOS window: java -version. You should see the response java version "1.3.1".  
⇒ Open Explorer and locate file "javaw.exe". Make sure the path of the file is entered correctly in the link for the operator panel icon. If there are problems with the Java Runtime Environment, re-install it. You will find it in the folder ‘Java’ on the installation CD. You cannot install the Java Runtime Environment directly from CD, so copy the folder to your hard disk and start the installation from the hard disk folder. |

**Converter Not Booting**

<table>
<thead>
<tr>
<th>Problem</th>
<th>The message &quot;Booting the Converter Software&quot; will not disappear from the operator panel</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reason and corrective measures</td>
<td></td>
</tr>
</tbody>
</table>
⇒ Open the converter window and observe it.  
⇒ Note all screen messages such as Error, Warning etc. and save the trace file of the Fuctional Code (V24-Trace) as well as the TrueProof log file.  
⇒ Report the error to your Océ service organisation, sending the screen messages and log with the report. |
Ready or Stop Controls Not Working

<table>
<thead>
<tr>
<th>Problem</th>
<th>The Ready or Stop controls on the operator panel do not respond when you click them.</th>
</tr>
</thead>
</table>
| Reason and corrective measures | The Java operator panel is not responding.  
⇒ Close the operator panel via the Task Manager (press <Alt>+<Ctrl>+<Del> and select the Task Manager; then select the task you want to end). Launch the panel again via the desktop icon. If the panel reacts again, you can continue production normally. Restarting the operator panel does not have any effect on the production workflow of the TrueProof Converter. |
| | TrueProof Converter not configured correctly  
⇒ Verify that there is a connection between the TrueProof Converter and SNMP and that the converter is running.  
⇒ Open the converter window and observe the messages that are shown when you press 'Stop', 'Ready' and the channel switch. Report the error (plus the messages you see) to your Océ service organisation. |
| | SNMP not configured correctly  
1. Check that SNMP is entered correctly in the network services and is running.  
2. Configure SNMP correctly; you might need to define that SNMP is to be launched automatically each time you start Windows NT. |

Host or Print Server Reports TrueProof Error

<table>
<thead>
<tr>
<th>Problem</th>
<th>The console of the host or print server displays an error message such as &quot;Intervention required&quot; or &quot;Error&quot;. This message refers to TrueProof.</th>
</tr>
</thead>
</table>
| Reason and corrective measures | ⇒ First find out if you have already transferred data to TrueProof at this point in time or not.  
Depending on whether you have begun the transfer, proceed with the following steps:  
⇒ Put the spool system into a defined state  
⇒ Stop archiving  
⇒ Put TrueProof into a defined state  
⇒ Make a backup of the troubleshooting documentation |
Put the spool system in a defined state
You see a message on the host or print server console referring to TrueProof. TrueProof has caused a hard error (for whatever reason) and stopped.
⇒ First put the spool system into a defined state. Refer to the operating manual of your host, spooler or print server for details about how to do this.
⇒ Putting the spool system into a defined state will stop the print file (you can repeat the file later). On some systems, you will need to detach TrueProof properly from the channel before resuming work.

Put TrueProof in a defined state
When a hard error occurs, the operator panel usually displays an error message and sets the printer controller to FD.00 Not Ready. The System Restart LED on the operator panel lights up yellow and an error message appears.
⇒ Make a note of the error message on a copy of the checklist in Appendix B.
In rare cases TrueProof or MS Windows may quit abruptly. Do not switch off the device yet! Certain diagnostic documentation would be lost if the device were to be switched off.

Save troubleshooting documents
⇒ Save the following documentation on TrueProof
   - Log file of TrueProof program
   - Trace file of Functional Code
⇒ Close all applications and then close Windows NT/2000.
Always reboot Windows following a hard error.
TrueProof also displays an error message when a soft error occurs. It is not necessary, however, to reboot Windows.
**TrueProof Unable to Receive Data**

<table>
<thead>
<tr>
<th>Problem</th>
<th>TrueProof will not accept data without an error message displaying on the host or print server console.</th>
</tr>
</thead>
</table>
| Reason and corrective measures | ⇒ Determine the state of the TrueProof device.  
⇒ Try to stop the TrueProof application with the Stop button on the operator panel. Note whether the host or print server registers the state transition  
⇒ If TrueProof does not react to your Start-Stop action, proceed as follows:  
⇒ Try to create all of the troubleshooting documentation (log file, PICC trace and SRA controller trace) and report the error to your Océ service organisation.  
⇒ Turn TrueProof off completely and restart.  
It may even be necessary to restart the print server. This has been observed with, for example, PRISMAproduction APA with PCL and a SCSI-connected TrueProof. If you have a SCSI connection, always start the print server after TrueProof has been rebooted and has entered Ready state. |

**Job Not Removed from Spooler**

<table>
<thead>
<tr>
<th>Problem</th>
<th>A job remains in the spooler even though it has been processed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reason and corrective measures</td>
<td>This is not an error. The job will disappear from the spooler management lists as soon as the next job arrives.</td>
</tr>
</tbody>
</table>

**PCL Job Control Not Working As Expected**

<table>
<thead>
<tr>
<th>Problem</th>
<th>The PCL job control is not working as expected.</th>
</tr>
</thead>
</table>
| Reason and corrective measures | Certain PCL drivers under Windows 95/98 do not generate print files in the correct manner.  
9. Make sure you always use the latest versions of drivers. |
### Font Problems in TIFF Images

<table>
<thead>
<tr>
<th>Problem</th>
<th>TIFF images appear as overlapping text; sections of text are in the wrong font; parts of the document are missing; message pages appear at the end of the job</th>
</tr>
</thead>
</table>
| Reason and corrective measures | Missing print resources. TrueProof has not been loaded with all the data required to execute the print job correctly. Some resources – fonts, images, logos, and overlays, for example – are missing. The result is incorrect print output. If TrueProof did not produce message pages (as could be the case with IPDS), the error might possibly not even be reported.  
⇒ Consult your applications engineer or the person who created the print job. |

### TIFF Images Rotated

<table>
<thead>
<tr>
<th>Problem</th>
<th>TIFF images have the wrong orientation. They are rotated in 90° multiples.</th>
</tr>
</thead>
</table>
| Reason and corrective measures | Check that the paper size in the print job matches the size in TrueProof  
⇒ Select “Configuration” from the “Jobs” menu “Paper Size”.  
⇒ Adjust the settings “Page Length” and “Print Width” to the print job, or change the settings in the print job.  
⇒ Make sure the job definition is set to simplex and two-up is off. |

### TIFF Images are Wrong Size or Resolution

<table>
<thead>
<tr>
<th>Problem</th>
<th>TIFF images are the wrong size or resolution.</th>
</tr>
</thead>
</table>
| Reason and corrective measures | Besides the paper size definitions in the printer configuration, you can also define clipping for the TIFF images in TrueProof. The definition might be incorrect.  
⇒ Choose ‘Setup’ -> ‘Configuration’ -> ‘Clipping’ and check that the settings are correct for this section. |
### TIFF Images Corrupt or Cannot be Opened

<table>
<thead>
<tr>
<th>Problem</th>
<th>TIFF images cannot be opened. The viewer displays an error message or exits abruptly. TIFF images appear as black triangles, jagged lines, and black areas. TIFF images look as though they have been cut into vertical and horizontal pieces and then fitted back together.</th>
</tr>
</thead>
</table>
| Reason and corrective measures                                          | Network transfer corrupts the data  
The transfer over the network has corrupted the data.  
⇒ Check this by saving the image data on the TrueProof device.  
⇒ Temporarily change the filing path.  
⇒ Select local drive C. See if the same problem occurs when you save the files locally. |
## Glossary

This table explains terms and abbreviations that are relevant to the TrueProof system. The "⇒" symbol indicates terms that are explained here in the glossary.

### APA

**All Points Addressable.** Capability of a printer to address (print at) any position in a co-ordinate system. This type of printer can print graphic elements (characters, lines and graphics) as well as character-by-character and line-by-line. APA printers are page printers that can interpret a page description language (such as IPDS).

### Bitmap

Representation of a rastered ⇒ print page or one ⇒ image stored in the memory of the controller or as a file. The number and arrangement of ⇒ pixels determine the composition of the bitmap.

### Booting

After turning on TrueProof, you have to launch the TrueProof Converter. This comprises the functional code and the TrueProof modules. Like on a normal printer, this process is called booting, and it takes approx. 30 seconds. You start the booting process with the Converter/Boot command on the TrueProof panel.

### Character assignment table

To generate ⇒ index data, the system has to convert each text character in the host data stream. An TrueProof character assignment table (CAT) is a file containing the character code equivalents for the host character codes. These codes are used to create the index data from the host data.

### Clip window

The bitmap which is loaded into the printer controller is generally larger than the print page to be stored in the archive. The bitmap contains a left margin reserved for marks used for paper post-processing (⇒ edge marks) and free areas (strips) on the right and bottom of the page for technical reasons. The unwanted strips are removed from the rectangle to be printed (the clip window) before the bitmap is compressed ⇒ compression.
Compression

A bitmap with a resolution of 240 DPI for an A4 page is 1986 pixels across and 2808 pixels down. The total is then 5,576,688 pixels, which requires approx. 700 Kbytes of memory. This is why bitmaps are generally compressed before storing. Using the CCITT FAX-G4 compression algorithm, it is possible to compress the image file of a print page so that it will only be 1/10th or 1/20th of its original size. When the page is due to be printed, software decompresses the image to its original size, without distortion. Compression and decompression of this format is often performed by specialised hardware.

The compression ratio depends on the contents, however. Pages that contain a grey raster ratio of 50% will generally be larger using the FAX-G4 compression method. Pages that contain a large amount of small print will not result in satisfactory results either.

Continuous feed printer

Synonym: fanfold printer. A printer that prints on continuous forms. The paper is usually perforated and pre-folded. The printer folds the paper after printing with the help of a fan (hence the name fanfold).

Controller

Printer controller

Cutsheet printer

A printer that processes single, cut sheets (as opposed to a continuous forms printer, which processes a continuous web from a roll or stack).

DLL

A Dynamic Link Library is part of a Windows program. The DLL is a separate file and is not linked (dynamically) until program runtime. This concept is used for drivers and for the TrueProof extensions to the FC.

DPI

Short for Dots per Inch (pixels per inch), Unit of measurement for the resolution. In IPDS mode the standard is generally 240 dpi. TrueProof 1.02 supports 240, 300 and 600 dpi in IPDS.

Edge marks

Edge marks consist of one, two or three narrow strip(s) printed right on the top, bottom left and right edges of the paper on a continuous feed printer. A change in the number of edge marks normally indicates the start of a new print job. The edge marks can be seen without fanning out the stack. TrueProof can interpret the IPDS command that triggers the change of edge marks and change to a different folder as a result.

Ethernet

Ethernet is a very common network type, defined in IEEE 802.3.
Glossary

**FAX-G4 compression**

Compression.

**File naming scheme**

A scheme for file names defines how path and file names are to be generated from TrueProof variables. You can use TrueProof variables in the syntax for files and folders, and the system will update the values for each new file it creates.

**Functional Code**

FC

Operating software embedded in the TrueProof Converter. It performs various tasks – for example, it determines the page description language, and controls all data transfer within the controller and at the interfaces to other devices.

**Host data**

Synonym for print data.

**Image**

(Synonym for graphic, graphic data, image data) An image is the reproduction that the functional code creates of the print data obtained from the IPDS data stream. The images are composed of a fine equidistant, two-dimensional raster of dots. Each image can comprise several logical pages. The images generated by TrueProof are in TIFF format.

**Image dot**

Smallest unit that a printer can tone. If you have a resolution of 240 DPI, one pixel will be approx. 0.11 mm in length and height. When ripping a page in the printer controller the system will generate a virtual image of the print page in memory. One bit in memory is the equivalent of one pixel; in most cases the logical “1” is a toned pixel and a “0” represents an untoned pixel.

**Inch**

Anglo-American unit of length. One inch is equal to 25.4 mm.

**IPDS**

IPX / SPX

Network protocol for Novell networks.

**Job**

A job is a number of printed pages that belong together. A job change on a continuous feed printer is generally indicated by edge marks or mark forms. On a cutsheet printer, they are made visible by header pages or by offset stacking (jogging). These facilities make it easier for operators to separate jobs. As a rule, jobs are the smallest units that printer operating personnel has to deal with.
### Glossary

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Logical page</strong></td>
<td>A user-defined rectangular area of the page that contains everything that will later be printed. The logical page can be larger or smaller than the physical page, or the same size. Its placement on the physical page is defined by the X and Y extents (LPP). The printable area is the area in which the logical and physical pages overlap.</td>
</tr>
<tr>
<td><strong>LPD</strong></td>
<td>Logical Page Descriptor: information about page parameters (size, relation, etc.) in the IPDS data stream.</td>
</tr>
<tr>
<td><strong>LPP</strong></td>
<td>Logical Page Position: information in the IPDS data stream about the placement of the print page on the form.</td>
</tr>
<tr>
<td><strong>NBT</strong></td>
<td>NetBIOS over TCP/IP is a construct of Microsoft Windows that enables Windows networks to operate with TCP/IP.</td>
</tr>
<tr>
<td><strong>NetBEUI</strong></td>
<td>A network protocol used in small, local Windows networks (does not support routing).</td>
</tr>
<tr>
<td><strong>NetBIOS</strong></td>
<td>Defines a software interface and name convention for Microsoft network support.</td>
</tr>
<tr>
<td><strong>NFS</strong></td>
<td>Network File System. A service in wide-area computer networks that makes it possible to have a distributed file system. NFS is a standard component of the package on UNIX systems. On client PCs, it is optional software.</td>
</tr>
<tr>
<td><strong>Page</strong></td>
<td>A page is the part of the image that is stored in the archive as raster data. An image can consist of several pages (for example, six remittance orders) or have two-up format (two pages). There are many different index relations between pages, indices and images.</td>
</tr>
<tr>
<td><strong>Page description language</strong></td>
<td>Format in which print data, resources and control data are sent to the printer. IPDS, Postscript and HP-PCL are widely used page description languages. TrueProof can process IPDS and (in future versions) PCL directly; other languages have to be converted first using special utilities on the print server.</td>
</tr>
<tr>
<td><strong>PC-NFS</strong></td>
<td>Network File System (NFS) permits shared access to files in heterogeneous environments. This is often used as a generic term even though it is the name of a product (Sun).</td>
</tr>
<tr>
<td><strong>PEM</strong></td>
<td>Print Error Marker, a special character generated by the printer firmware to denote errors. A PEM is generated, for example, when you try to print outside the printable area.</td>
</tr>
<tr>
<td><strong>Physical page</strong></td>
<td>Real page on the output medium (paper). On continuous feed paper, a page is the area inside the feed hole margin and between the perforations. A physical page can contain one or more logical pages.</td>
</tr>
<tr>
<td><strong>Pixel</strong></td>
<td>The technical term for an image dot.</td>
</tr>
<tr>
<td><strong>PJL</strong></td>
<td>Printer Job Language by the Hewlett-Packard Company. Control language for compatible printers that operates at a “higher” level than PCL and other printer languages. If the printer has a bi-directional connection, PJL commands can be used both to change the printer’s status and to query its status.</td>
</tr>
<tr>
<td><strong>Print data</strong></td>
<td>The spool system converts the application data, which is stored on the host, into print data (here generally an IPDS or PCL5e data stream without HP GL), by formatting it, adding resources and other information generated by the spooler. The functional code interprets the data to generate a raster image. Synonym for host data.</td>
</tr>
<tr>
<td><strong>Property</strong></td>
<td>The current configuration of each TrueProof component is described by a set of properties. The LogPath property, for example, belongs to the control component and defines the file naming scheme for log files.</td>
</tr>
<tr>
<td><strong>Resolution</strong></td>
<td>Synonym: Printer resolution, print resolution. Number of dots per unit of length. This value is generally in DPI.</td>
</tr>
<tr>
<td><strong>Resources</strong></td>
<td>The portion of the data stream which is sent to the printer prior to the actual texts to be printed. Resources are stored in the printer controller. They include fonts, logos, graphics, forms, and texts for data documents. The resources are combined with the variable texts when the pages are prepared (RIPping) for output. Synonym: Print resources.</td>
</tr>
<tr>
<td><strong>RIPping</strong></td>
<td>Preparation of an output page by a Raster Image Processor (RIP). The TrueProof RIP is the same RIP used in high performance printers. It converts the print data stream (for example, IPDS or PCL) by correctly positioning the graphic elements of the page on a bitmap of the page to be printed.</td>
</tr>
<tr>
<td><strong>Samba</strong></td>
<td>Samba emulates a Windows network under UNIX. It is available as freeware for many UNIX systems.</td>
</tr>
<tr>
<td><strong>Sequence</strong></td>
<td>A sequence is an associated chain of jobs, normally created during a single TrueProof session (from the time the printer controller is booted through to ending the session).</td>
</tr>
</tbody>
</table>
Glossary

SMB  **Server Message Block**: a data release protocol that permits different systems easily to access files stored on remote systems. SMB is at the core of networking support on Windows systems.

SNIPDS  **Siemens Nixdorf Intelligent Printer Data Stream**: a page description language for device-oriented print data that APA printers can interpret.

SNMP  **Simple Network Management Protocol** is an easy-to-use protocol for managing and configuring network nodes such as workstations, hosts, printers, routers and bridges. This global standard makes it possible for network administrators to monitor and control workstations from a remote site.

TCP/IP  **Transport Control Protocol / Internet Protocol** is designed for large networks.

TIFF  **Tagged Image File Format**: the de-facto standard file format for pixel images. With this format, it is possible to store images of any size using different compression algorithms.

Token Ring  **Token Ring** is a type of network that uses ring topology, which is widespread in IBM environments.

Two Up printing  On Océ printing systems using 17” print width, this function prints two A4 portrait pages side-by-side. This increases the printer’s throughput without having to reduce the font size.  Two-up modes.

Two-up modes  There are two kinds of two-up print modes:

* Two-up mode is typical for Océ printers. In this mode, the system prints two pages side-by-side, in a manner that is transparent for the host system. To print XtwoUp using TrueProof, two pages have to be extracted from the image.
* In software two-up, the host application processes the print data such that two (software two-up) or several (software N-up) logical pages are printed on each physical page. In this case, TrueProof identifies the complete physical page as a single index page and single image page.
Index

A
APA 105, 108
ASCII 33, 35

B
Bitmap 103
Booting 103

C
Cache Browser 75
Character assignment tables 33
Clip window 103
Code page 34, 35
Configuration 32
  - Channel, Emulation... 51
  - Clipping... 54
  - Converter Preferences... 67
  - Paper Shift... 50
  - Paper Size... 46
  - Separation 57
  - Text Filter... 55
Continuous Mode 85
Controller 104
Converter 41
  - Boot 42
  - Connect 41
  - Down 42
Cut sheet printer 104

D
Deinstallation 15
Directory 29
DLL 104
DPI 104

E
EBCDIC 33, 35
Edge marks 29, 57, 104

F
File name syntax 105
Form definition 30
FORMDEF 30

H
Host data 105

I
Image 105, 107, 108
Input data
  - definition and content 2
Installation 7, 35
  - licenses 13
  - required hardware and software 7
IPDS 105, 106, 107

J
Job 105

L
Licenses 13
Logical page 30, 106
LPD 106
LPP 106

M
Mark Forms 29
Menu
  - Converter 41
  - Output 70
  - Setup 43
  - View 68

N
NBT 106
NetBEUI 106
NetBIOS 106
NFS 106
Index

O
Operator panel 38
Operators for path variables 66

P
Page 105, 106, 108
- last 29
- logical 30
Page copies 31
Page Definition 30
Page Description Language 106
PAGEDEF 30
Paper format 30, 31
PCL 107
PC-NFS 106
PEM 106
Pixel 107
PJL 107
Print data 105, 107, 108
Print data stream 2
Product Architecture 2
Properties of jobs 107
Property 107
Physical page 30

R
Rastering 107
Resolution 107
Resources 107
Restrictions 6

S
Samba 107
Sequence 107
Setup
- Configuration 46
- Delete 45
- Load 43
- Save 43
- Save as 44
SMB 108
SNIPDS 108
SNMP 108

T
TIFF 108
TokenRing 108
Troubleshooting 96
TrueProof Cache Browser 75
TrueProof Viewer
- Continuous Mode 85
TrueProof Viewer (PRISMAproduction) 89
TrueProof Viewer (Windows) 81
Two-up modes 106, 108

U
UEL 58

V
Viewer (Windows) 81